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Intended Audience
Welcome to Release 12.1 of the Oracle Installed Base Implementation Guide.

See Related Information Sources on page x for more Oracle Applications product 
information. 

TTY Relay Access to Oracle Support Services
To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer 
Assistant will relay information between the customer and Oracle Support Services at 
1.800.223.1711. Complete instructions for using the AT&T relay services are available at 
http://www.consumer.att.com/relay/tty/standard2.html. After the AT&T Customer 
Assistant contacts Oracle Support Services, an Oracle Support Services engineer will 
handle technical issues and provide customer support according to the Oracle service 
request process. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation accessible
to all users, including users that are disabled. To that end, our documentation includes 
features that make information available to users of assistive technology. This 
documentation is available in HTML format, and contains markup to facilitate access by
the disabled community. Accessibility standards will continue to evolve over time, and 
Oracle is actively engaged with other market-leading technology vendors to address 
technical obstacles so that our documentation can be accessible to all of our customers. 
For more information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/. 
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Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise 
empty line; however, some screen readers may not always read a line of text that 
consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Structure
1  Overview of Oracle Installed Base
2  Implementation and Setup for New Users
3  Implementation and Setup for Upgrade Users
A  Oracle Installed Base System Profile Options and Debug Information
B  Seeded Data
C  Processing Errors

Related Information Sources
Oracle Installed Base User Guide

Integration Repository
The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your 
instance is patched, the repository is automatically updated with content appropriate 
for the precise revisions of interfaces in your environment. 

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data unless 
otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
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SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your 
data and you lose the ability to audit changes to your data. 

Because Oracle Applications tables are interrelated, any change you make using an 
Oracle Applications form can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your tables 
get out of synchronization with each other, you risk retrieving erroneous information 
and you risk unpredictable results throughout Oracle Applications. 

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps track 
of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Overview of Oracle Installed Base

This chapter covers the following topics:

• Summary of Oracle Installed Base

• Features of Oracle Installed Base

• Integration Points and Dependencies for Oracle Installed Base

Summary of Oracle Installed Base
Oracle Installed Base is an item instance life cycle tracking application that facilitates 
enterprise-wide life cycle item management and tracking capabilities. Oracle Installed 
Base tracks an item from the time that it is received in inventory, in work in process, in 
projects, at customer sites, and throughout the return and repair process. It records a 
history of changes to tracked items and supports the creation and maintenance of 
Oracle Installed Base configurations.

Oracle Installed Base is a centralized repository of information for an item instance and 
its tracking details including location, status, ownership, party relationships, account 
relationships, contact relationships, configuration data, and the change history of 
customer items or corporate assets. The application includes drill-down capability to 
obtain details of inventory, work in process, and order management transactions 
affecting an item's tracking attributes.

Additionally, Oracle Installed Base provides links to detailed information from 
contracts, service requests, repair orders initiated for an item instance, and counters 
associated with the item instance.

Note: Oracle Installed Base support is subject to rules, conditions, and 
limitations discussed in various sections of this guide. These are not 
exhaustive. Although most situations are covered, it is not possible to 
specify all rules, conditions, and limitations with regard to the 
functionality of the application.
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Features of Oracle Installed Base

Functional Overview
Oracle Installed Base is capable of tracking serialized and non-serialized item instances 
including:

• Tangible items such as manufactured, purchased, and shipped items

• Intangible items such as software, services, licenses, and agreements

• Tangible assets including fixed, movable, and leased assets

Oracle Installed Base leverages existing Oracle applications and is fully integrated with 
the Oracle E-Business Suite.

Key features and functionality include the following:

• Item instance maintenance

• Support for inventory transactions

• Centralized repository of information:

• Item instance consolidated transactions history

• Item instance timestamp and version label history

• History of Oracle E-Business Suite transactions affecting Oracle Installed Base 

• Instance relationships with multiple party/accounts 

• Configuration support and instance-to-instance relationships

• Open Interface and Quick Edit capabilities:

• Mass load of item instances by an open interface

• Quick online edit of attributes for a group of item instances

• System grouping of item instances

• Capability of user-defined extended attributes 

Instance Maintenance 
Oracle Installed Base provides for creation, updating, querying, and copying of 
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instances through Oracle Installed Base user interfaces and through integration with 
other applications. These include Oracle applications such as: 

• Oracle Service Contracts

• Oracle Field Service 

• Oracle Depot Repair

• Oracle Complex Maintenance, Repair, and Overhaul

• Receiving

• Oracle Work in Process

• Oracle Inventory

• Oracle Projects

• Oracle Order Management

• Shipping 

• Oracle Purchasing

• Contact Center and the eBiz Center

Asset creation and maintenance can be invoked using Oracle Asset Tracking.

It provides tracking of location, status, addresses, contacts, business party relationships,
inter-instance relationships, extended pricing, instance attributes, and a host of other 
item instance attributes.

Instance maintenance can be directly performed using robust HTML query, search, and 
edit capabilities.

Support for Inventory Transactions
Oracle Installed Base supports creation and update of item instances and attributes for 
transactions originating in Oracle Inventory. These include internal transactions such as
internal order shipments and subinventory transfers, discrete manufacturing 
transactions such as WIP component issue and WIP component return, and external 
transactions such as sales order shipments to external customers. Oracle Installed Base 
aslo provides instance maintenance for transactions involving Oracle Purchasing, 
Contact Center, and e-Biz Center.

Note: Oracle strongly recommends that you set up the Inventory Install
Base tracking parameter at the item master level. You must select items 
as Trackable for all organizations.
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Similarly, you must set lot, locator, revision, serial, and others at the 
master level. 

The Oracle Installed Base User Guide provides a comprehensive list of all transactions that
Oracle Installed Base supports, including those that are triggered by Oracle Inventory.

Centralized Repository of Information
Here are examples of information that you can find in the centralized repository that is 
Oracle Installed Base:

• Consolidated transactions history for an item instance

Oracle Installed Base provides a single, centralized user interface to view and drill 
down from all transactions affecting tracking attributes for an item over the life of 
the item instance. Transaction details include, for example, transaction type, source 
application, transaction, line reference, and transaction date. 

• Timestamp and version label history for an item instance

In the Item Instance History page you can view the state of the attributes of an 
instance by specifying a date-time stamp or a version label. This feature provides 
valuable information regarding what an item instance looked like at a given point 
in time.

• History of Oracle E-Business Suite transactions affecting Oracle Installed Base

Oracle Installed Base provides the ability to query transactions by date range, 
status, and transaction types across Oracle E-Business Suite applications. It pulls 
together information from multiple applications and presents it in a single, central 
user interface.

Multiple Party/Account Relationships
With Oracle Installed Base you can relate an item instance to multiple entities called 
parties. The parties can be different party types. Thus an item instance may have been 
Sold To party A but is now Owned By party B. It may be Shipped To party C, and so 
on. The entities may have type values such as Party, Vendor, Employee. For each party 
type, you can define relationship types such as Owner and Service Provider. Each party 
can have multiple accounts.

This feature supports the multiple business relationships required by today's business 
globalization and outsourcing requirements.

Configuration Support and Instance-to-Instance Relationships
Oracle Installed Base provides the ability to store configurations of item instances and 
to access the history of a configuration.

This functionality includes creating and maintaining configurations. It builds 
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hierarchical configurations at WIP assembly completion by formulating Component-Of 
relationships between instances. It supports parent-child bill of material (BOM) 
structure at the point of sales order shipment. 

Multiple types of relationships between instances are supported. For example, Oracle 
Installed Base connects two or more components in a communications network by 
creating Connected-To relationships between item instances. This capability reflects 
Oracle Installed Base integration with the Oracle Telecommunications Service Ordering 
solution of Oracle Configurator.

Open Interface Mass Load and Mass Update Capabilities
Oracle Installed Base provides the Open Interface feature to mass load item instances. 
This is useful during initial conversion and for synchronizing multiple environments. It 
can be used to create new instances or to update existing item instances. It can also be 
used to create or update relationships between item instances including replacing 
instances in Component-Of configurations.

Additionally, Oracle Installed Base provides the Mass Update feature. With this feature 
you can select a group of item instances based on a set of search criteria and invoke 
attribute changes for all item instances in the group. For example, you can quickly and 
conveniently change ownership, location or contacts for a group of instances. The 
transactions can also be set to run on a future date.

System Grouping of Item Instances
Oracle Installed Base has the ability to group item instances under a construct called a 
system. For example, all copier machines on the fifth floor of a building or those 
belonging to a specific department can be grouped under a system. You can define, 
view, and invoke specific changes to item instances within the system, or grouping. 
Additionally, you can build hierarchies of systems and link multiple systems in 
parent-child hierarchies or relationships.

Extended Attributes
Oracle Installed Base offers the flexibility of multi-level, user definable additional, or 
extended, attributes associated with an item instance to fit a variety of business 
requirements. The application also stores pricing attributes for an item instance and 
makes them available for subsequent use by Oracle E-Business Suite applications 
including Oracle Service Contracts. That application uses service programs or extended 
warranties where price is dependent on the attributes of a item.
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Integration Points and Dependencies for Oracle Installed Base

Integration with the Oracle E-Business Suite
Oracle Installed Base has the following integration points within the Oracle E-Business 
Suite:

• Counters and Notes (update capabilities)

• Direct updates from Oracle Field Service and Oracle Complex Maintenance Repair, 
and Overhaul

• View and reference accessibility from multiple applications such as Oracle 
Contracts, Oracle Field Service, Oracle Depot Repair, and Oracle Customer Support 

• Oracle Trading Community Architecture for querying parties and accounts and 
building item instance to party relationships

• Oracle Inventory (receiving and other inventory transactions)

• Oracle Order Management (shipping, fulfillment, and RMA receipts). Includes 
integrations with the Oracle Telccomminications Service Ordering (TSO) 
functionality as well as the Oracle Order Management Partner Ordering process.

• Oracle Assets (Oracle Asset Tracking-specific updates through mass additions

• Oracle Projects (Oracle Asset Tracking-specific updates to projects)

• Oracle Work in Process (move transactions, assembly completion, configuration 
support, and others)

• Oracle e-Biz Center & Contact Center. A new tab provided with Contact/e-Biz 
Center window enables direct access to Oracle Installed Base.

• Oracle Project Contracts (shipment transactions)

• Oracle Purchasing (inter-company drop shipment and PO adjustments)

• Trading Community Architecture (TCA) party for party and relationship

Note the following points with regard to integration with TCA and Oracle Quoting:

• When using the TCA merge routines with Oracle Installed Base records, Oracle 
recommends that the party merge be done before the account merge. In addition, 
the internal party that is set up in the Oracle Installed Base parameter cannot be 
used in the merge. For details, refer to Section 2.5.1, page 2-15 in this document.
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• When entering a quote, you can invoke the transaction detail to enter additional 
information for Oracle Installed Base. When the quote becomes an order, the 
transaction detail is copied against an Oracle Order Management order. This is 
processed when the order is shipped as described in the Oracle Order Management 
integration. 

The application uses the Service Fulfillment Manager (SFM) event queue for 
communicating transactional updates from Oracle Inventory to Oracle Installed Base.

Inventory Receipt and Purchase Order Receipt
If an item is set up as trackable in Oracle Installed Base, then an inventory receipt such 
as miscellaneous receipt or PO receipt causes the creation or update of an Oracle 
Installed Base instance. At the time the inventory transaction happens, a message is sent
to the SFM Event Queue. It is automatically dequeued and processed to update Oracle 
Installed Base.

For non-serialized items, if an instance already exists at the same subinventory location,
then it is added to the quantity of the instance with the same subinventory location. If 
an instance for the same item subinventory location does not exist, then a new instance 
is created.

If an item is serial controlled at receipt or is predefined, then an instance is created for it 
with quantity of 1 with location in the subinventory location.

If an item is serial controlled at order issue, then it is treated as a non-serialized 
controlled item in inventory. Only at order-issue time, when it gets a serial number, is 
an instance with the serial number created.

Inventory Transactions
If an Oracle Installed Base trackable item has been received into inventory and an 
Oracle Installed Base instance has been created, then any subsequent inventory 
transactions will be tracked in Oracle Installed Base as well.

Note: Oracle strongly recommends that you set up the Inventory Install
Base tracking parameter at the item master level. You must select items 
as Trackable for all organizations.

Similarly, you must set lot, locator, revision, serial, and others at the 
master level. 

For an inventory transfer or move order transaction, the location of an instance is 
updated to reflect the new location for a serialized item. For a non-serialized item, the 
quantity of the instance at the From location is subtracted, and the quantity of the 
instance at the To location is increased by the quantity being moved. If the item is 
issued to a WIP job, then the location of the item reflects the WIP job number. If it is 
issued to an asset, then it reflects the asset number. If it is issued to a project/task, then 
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the location of the instance shows the project and task number. Refer to Oracle Asset 
Tracking documentation for more details.

The Oracle Inventory transactions associated with Oracle Installed Base appear in 
Appendix A, Oracle Transactions Interfacing with Oracle Installed Base, of the Oracle 
Installed Base User Guide.

The work-in-process inventory-sourced transactions are described in further detail in 
Section 1.3.5, "WIP Integration", page 1-12.

Oracle Order Management Integration
The integration with Oracle Order Management is the only integration that implements 
the functionality of the Oracle Installed Base Transaction Details window. This includes 
RMA receipt, sales order shipment, and sales order fulfillment. The functionality of the 
Oracle Installed Base Transaction Details window is not supported for internal sales 
orders.

RMA Receipt 
An RMA return receipt generates an inventory receipt material transaction in the 
Inventory application. If a serialized item never existed in Oracle Installed Base, then 
the RMA receipt creates a new instance with the location in inventory. For 
non-serialized items, first create the instance with the required quantity using the 
Oracle Installed Base user interface and then reference it in the RMA. If the instance 
already exists in Oracle Installed Base, then this return can cause a change of location to 
inventory and other changes such as status and owner as specified in the transaction 
type setup used to process the transaction.

In the sales return line, installation detail can be invoked to specify additional details for
this instance and other related instances for this update to Oracle Installed Base. 

Oracle Installed Base supports the Order Management RMA fulfillment process for 
non-shippable items under specific terms and conditions. Important conditions include 
the following:

• The item must be flagged as Oracle Installed Base trackable.

• Instance Reference must be entered in the Transaction (Installation) Details window
for Oracle Installed Base update.

• RMA - Oracle Installed Base interface workflow customizing is required.

Oracle Installed Base supports RMA fulfillment by one or more of the following events:

• Reduction in quantity (If the quantity is reduced to zero, then it is automatically 
expired.)

• Instance expiration
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• Change in status

• Change in configuration relationship

Instance attributes are updated based on the associated transaction types in the 
transaction details window.

Refer to Section 1.3.9, page 1-15 for information on the use of transaction detail. To use 
transaction detail, the transaction types being used have to be previously set up. Refer 
to Section 2.5.24, page 2-35 for instructions on setting up transaction types.

Sales Order Shipment
For an Oracle Installed Base trackable, shippable item, a shipping transaction generates 
an inventory issue transaction in the Oracle Inventory application.

For a serialized item already in inventory, this transaction causes a change of location 
and ownership, depending on the transaction type being used.

For items serialized at sales order issue, the first-time shipment transaction causes the 
creation of a new instance with the serial number. If it has trackable components, then 
the component instances and component-of configuration for these components are 
built as well.

For non-serialized items, the quantity is subtracted from the instance at the inventory 
location, and a new instance is created with the customer ownership and location.

Configuration Creation at Sales Order Shipment
Oracle Installed Base supports Oracle Order Management integration based creation of 
configurations for the following:

• Assemble-to-order (ATO) models, configured item, ATO option class and 
components

• Pick-to-order (PTO) models, included item, PTO option class and components

• Kits and components items

It is important to note items must be Oracle Installed Base trackable, and non-shippable 
items must be fulfilled in order to be represented in a configuration.

BOM Based Configurations
Key Rule: Configurations are built only for a parent item instance with Quantity = 1.

Oracle Installed Base supports the creation of BOM based configurations at initial 
shipment. Component-of relationships are created between trackable parent and 
component instances.

Notes Regarding PTO and ATO Models
The creation of a PTO model is supported as in previous versions of Oracle Installed 
Base. At the time of sales order line processing, Oracle Configurator enables the 
selection of optional items to be put into the PTO model. As a result, additional sales 
order lines are created for the mandatory and optional items. If they are Oracle Installed
Base trackable, then at the time of sales order shipment, instances of the top model, the 
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trackable components, and the component-of relationships are created in Oracle 
Installed Base. The PTO model need not be serialized controlled. 

In all cases, at the sales order line for a sales order, installation detail can be invoked to 
specify additional details for this instance and other related instances, for this update to 
Oracle Installed Base. Refer to Section 1.3.9, page 1-15 for information on the use of 
installation detail. 

To use the installation detail, the transaction types being used have to be previously set 
up. Refer to Section 2.5.24, page 2-35 for instructions on setting up transaction types.

The creation of an ATO model is supported as well. At the time of sales order line 
processing, Configurator enables the selection of optional items to be put into the ATO 
model. Then a WIP job can be created for the configured item to be built in WIP. At the 
time of WIP assembly completion, the configured item instance and its configuration 
are created with the location in inventory. When it is shipped, the location and 
ownership will be changed to that of the customer. The ATO model need not be 
serialized controlled.

Sales Order Fulfillment
Oracle Installed Base supports sales order line fulfillment of shippable or 
non-shippable, Oracle Installed Base trackable items. Workflow customizing is 
required. Details are provided in subsequent sections. 

Fulfillment of an order line invokes the Oracle Installed Base interface and 
appropriately creates or updates Oracle Installed Base item instances.

Note: You can replace the Service Fulfillment Manager (SFM) queue 
with a concurrent program to process the MACD (Move, Add, Change 
and Disconnect) sales orders.

Use the CSI: Use Parallel Mode profile option to indicate which 
approach (SFM or Concurrent) to use in order to process order lines in 
Oracle Installed Base. If you set the profile option value to Yes, the new 
concurrent program will process the transaction lines.

Concurrent programs are:

• IB Transaction Lines Import

• IB Transaction Lines Import Worker

The IB Transaction Lines Import concurrent program is a manager 
which batches the lines and assigns workers to process them. The 
number of workers will be up to the maximum that you specify in the 
concurrent program. Schedule the IB Transaction Lines Import 
concurrent program to run every minute. In case you want to retain 
processed data, the Purge option is provided. Use Oracle Install Base 
Admin responsibility to run the IB Transaction Lines Import program.

In case of any errors, the current rows will be updated to an error 



Overview of Oracle Installed Base    1-11

status. The worker can resume processing other order lines. Error rows 
can be resubmitted through the Installed Base - Transaction Errors 
Processing form.

Configuration Creation at Sales Order Fulfillment
Oracle Installed Base supports creation of the following configurations based on 
integration with Oracle Order Management:

• PTO models, included items, PTO option class and components

• Kits and components items

• BOM-based configurations

Key Rule: Configurations are only built for a parent item instance with Quantity = 1.

Oracle Installed Base supports the creation of BOM-based configurations at fulfillment. 
Component-of relationships are created between trackable parent and component 
instances.

In all cases, at the sales order line for a sales order, transaction detail can be invoked to 
specify additional details for this instance and other related instances for this update to 
Oracle Installed Base. Refer to Section 1.3.9, page 1-15 for information on the use of 
transaction details. 

To use the transaction detail, the transaction subtypes being used must have been 
previously set up. Refer to Section 2.5.24, page 2-35 for instructions on setting up 
transaction subtypes.

Ordering Process for End Customers and Partners 
Oracle Installed Base is integrated with the Oracle Order Management end-customer or 
partner ordering process, and information that is specific to end customers can be 
automatically captured in Oracle Installed Base from sales orders.

You set up order management default values to specify Oracle Installed Base ownership
and the current and installed location in sales orders.

Oracle Installed Base populates the owner, owner account, current location, and the 
installed location in the transaction detail, based on the order management defaults or 
entries in the sales order line. 

Following sales order fulfillment, these values are appropriately reflected in Oracle 
Installed Base for an item instance. 

The owner/account can come from the sold-to party/account or the end-user/account, 
the current location can come from the shipped-to location, end-user location, sold-to 
location, or deliver-to location, the installed location can come from shipped-to location,
end-user location, sold-to location, or deliver-to location. 
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WIP Integration
Oracle Installed Base supports and reflects the majority of inventory transactions 
sourced from WIP jobs and WIP transactions including component-of configuration 
creation at WIP assembly completion. 

WIP assembly completion creates a receipt and a subsequent transaction in Oracle 
Inventory. The Oracle Installed Base integration point with WIP is strictly through the 
inventory material transaction, not through any internal WIP transactions.

See Section 1.3.3, page 1-7 for more information about inventory transactions.

Assembly Completion and Allocation
The creation of Oracle Installed Base configurations in the context of WIP integration is 
determined by several variables including auto allocate parameter, genealogy enabled, 
single versus multiple job assembly quantity, serial control, trackable components, and 
others.

In general configurations are created subject to Rule 1 below.

Rule 1
For auto allocate = 'Y' and genealogy not enabled, configurations are built based on job 
requirements. Generally, excess component quantity is not attached to a configuration. 
Excess quantity is only attached if there is no job requirement.

Other considerations include the following:

• Configurations are only built for serialized assemblies (serialized at receipt or 
predefined).

• Components are added or removed from existing configurations following 
post-completion transactions. (For example, WIP component issue/return and WIP 
negative component issue/return)

• Oracle Installed Base provides configuration support for work order-less WIP 
completions.

• Configurations (component removal and installation) are not supported at 
assembly completion for CMRO WIP jobs.

For assembly quantity = 1, configurations are created and modified based on issued 
component quantities. An exception is the following repair/upgrade scenario: If 
item/serial number A is issued to a job and job completion creates the same item/serial 
number or the same item with a new serial number B, then the original serial number A 
is not created as a component of itself (original serial number A or new serial number 
B).

For multi-quantity assembly jobs, configuration creation is governed by the Auto 
Allocate install parameter: Auto Allocate = 'Y' and genealogy not enabled.
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For serialized components:

• Completion configuration is based on a random allocation (order of serial numbers)
in the ratio of total job component quantity required to job assembly quantity, if job 
requirements exist. If no job requirements exist, then configuration is based on 
component quantity issued to job assembly quantity. Excess quantity is randomly 
issued.

• Post component issues are added based on ratios specified in job material 
requirements, subject to Rule 1.

For non-serialized components:

• Component issues are added based on quantity required to job quantity if job 
requirements exist. Otherwise, component issues are based on quantity issued to 
job quantity if no requirements exist.

• Post component issues are added based on ratios specified in job material 
requirements. Auto Allocate = 'N' and genealogy enabled.

For serialized components:

• Configuration is created according to genealogy or from the parent serial number in
the MTL table.

• No random allocation is performed.

For non-serialized components:

• Configuration relationships are built only for specific quantity allocations.

• Only a single level configuration is built for a given WIP job. To process multiple 
levels of configuration, multiple jobs must be created and executed for 
subassemblies.

At the time of sales order shipment, the ownership and location are changed to that of 
the customer, depending on the transaction being used. Key supported WIP 
transactions include:

• WIP Component Issue

• Wip Component Return

• Wip Negative (Wip-ve) Component Issue

• Wip-ve Component Return

• Wip Assembly Completion

• Wip Assembly Return
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Support for Internal Sales Orders
The internal sales order is one of the means for transferring items between internal 
organizations. Oracle Installed Base supports the internal order process subject to 
specific rules and conditions. It updates item instances for internal order transactions 
including internal order pick, internal order in-transit shipment, internal order direct 
shipment and internal order in-transit receipts.

The key condition affecting Oracle Installed Base support for internal sales orders 
requires selection of the Oracle Inventory Oracle Installed Base tracking parameter at 
item master level. Items must be selected as Trackable for all organizations. Similarly, 
lot, locator, revision, and others must be set at the master level. Generally Oracle 
Installed Base supports organization-level serial control combinations provided by 
Oracle Inventory. Specific conditions such as serialized at receipt item in Org A to 
serialized at sales order issue item in Org B are not supported.

In general, Oracle Installed Base updates the following item attributes in the internal 
sales order process.

Serialized Items:

Inventory Location attributes (Organization ID, Sub-inventory, Location, Locator, Lot) 
are appropriately updated to reflect the transferred organization.

Non-Serialized Items:

Instances may be created and/or updated (quantity decreased/increased) appropriately 
based on whether instances exist, negative quantities are allowed, and so on.

In-Transit Internal Order Shipments:

• Instance usage and location type are updated to 'In-Transit' at shipment subject to 
serial/no-control rules.

• Instance usage and location type are updated to 'In-Inventory' on receipt subject to 
serial/no-control rules.

Direct Internal Order Shipments:

Instance usage and location type are updated to 'In-Inventory' subject to 
serial/no-control rules.

Inter-Organization Transfers:

These generally are subject to the same rules and processes listed earlier in this section.

Asset Integration
For information about asset integration, refer to Oracle Asset Tracking Implementation 
Guide and Oracle Asset Tracking User Guide.
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Project Integration
For information about project integration, refer to Oracle Asset Tracking Implementation 
Guide and Oracle Asset Tracking User Guide.

Use of Transactions Details
The Transaction Details window is used to capture additional information that is used 
to update the instance, an RMA return line, and a sales order line.

The Transaction Details can be activated on the sales order line window by clicking 
Actions and selecting Installation Details. For a full description of this window, refer to 
"Using the Order Management Transaction Details Window" in Oracle Installed Base User
Guide and online help.
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2
Implementation and Setup for New Users

This chapter covers the following topics:

• Product Dependencies and Requirements

• Setup Checklist for New Users

• Related Setup Steps within Other Oracle Applications

• Related Setup Steps within Oracle Asset Tracking

• Setup Steps within Oracle Installed Base

Product Dependencies and Requirements
The following modules must be installed and set up for Oracle Installed Base to work. 
Refer to the appropriate guides to install and set up these modules:

• Oracle Inventory

• Oracle Asset Tracking

• Oracle Service Fulfillment Manager

• Oracle Order Management

• Oracle Purchasing (Optional)

• Oracle Accounts Receivable

• Oracle Work in Process (Optional)

• Oracle Bills of Material
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Setup Checklist for New Users
The following provides a checklist of setup steps for new users of Oracle Installed Base. 

.

Step 
Number

Title Required 
or 
Optional

Seeded
?

Extensible
?

Section 
Reference

1. Synchronize On-Hand 
Balance with Oracle 
Inventory, page 2-6

Required NA NA Section 2.3.1, 
page 2-6

2. Set Up Inventory Serial 
Control at the Master Level, 
page 2-7

Required NA NA Section 2.3.2, 
page 2-7

3. Set Up Oracle Installed Base
Items in the Item Master, 
page 2-7

Required NA NA Section 2.3.3, 
page 2-7

4. Set Up Parties, page 2-7 Required N N Section 2.3.4, 
page 2-7

5. Set Up Vendors, page 2-7 Optional N N Section 2.3.5, 
page 2-7

6. Set Up Employees, page 2-
8

Optional N N Section 2.3.6, 
page 2-8

7. Set Up Party Accounts, 
page 2-8

Required N N Section 2.3.7, 
page 2-8

8. Set Up Party Contacts, page 
2-8

Required N N Section 2.3.8, 
page 2-8

9. Verify the Setup of the 
Oracle Service Fulfillment 
Manager Event Queue, page
2-8

Required N N Section 2.3.9, 
page 2-8

10. Set Up the Action Menu in 
Oracle Order Management, 
page 2-9

Required N N Section 2.3.10, 
page 2-9
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Step 
Number

Title Required 
or 
Optional

Seeded
?

Extensible
?

Section 
Reference

11. Set Up the Order 
Management Workflow for 
Non-Shippable Items, page 
2-10

Required N N Section 2.3.11, 
page 2-10

12. Run the License Manager 
Program, page 2-13

Required N N Section 2.4.1, 
page 2-13

13. Verify the Setup of Four 
Profile Options for Oracle 
Asset Tracking, page 2-13

Required N N Section 2.4.2, 
page 2-13

14. Verify Location IDs in 
HZ_LOCATIONS, page 2-
13

Required Y N Section 2.4.3, 
page 2-13

15. Verify Codes for Asset 
Update Statuses, page 2-14

Optional Y N Section 2.4.4, 
page 2-14

16. Set Up Installation 
Parameters, page 2-15

Required N N Section 2.5.1, 
page 2-15

17. Set Up Codes for 
Party-Account and 
Party-Contact Relationship 
Types, page 2-18

Required Y Y Section 2.5.2, 
page 2-18

18. Verify Codes for Instance 
Relationship Types, page 2-
19

Required Y N Section 2.5.3, 
page 2-19

19. Verify Extended 
Attribute-Level Codes, page
2-20

Required Y N Section 2.5.4, 
page 2-20

20. Set Up Extended Attribute 
Pools, page 2-20

Optional N Y Section 2.5.5, 
page 2-20

21. Set Up Extended Attribute 
Classifications, page 2-21

Optional N Y Section 2.5.6, 
page 2-21
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Step 
Number

Title Required 
or 
Optional

Seeded
?

Extensible
?

Section 
Reference

22. Set Up Extended Attributes,
page 2-21

Optional N Y Section 2.5.7, 
page 2-21

23. Verify Accounting 
Classification Codes, page 
2-21

Required Y N Section 2.5.8, 
page 2-21

24. Set Up Instance Type 
Codes, page 2-22

Optional N Y Section 2.5.9, 
page 2-22

25. Verify Codes for Instance 
Location Sources, page 2-22

Required Y N Section 2.5.10, 
page 2-22

26. Verify Party Sources, page 
2-23

Required Y N Section 2.5.11, 
page 2-23

27. Set Up Codes for 
Instance-Operating Unit 
Relationship Types, page 2-
24

Required Y Y Section 2.5.12, 
page 2-24

28. Set Up Version Labels, page
2-25

Optional Y Y Section 2.5.13, 
page 2-25

29. Set Up System Type Codes, 
page 2-25

Required N Y Section 2.5.14, 
page 2-25

30. Set Up Split Process 
Reasons, page 2-25

Optional N Y Section 2.5.15, 
page 2-25

31. Verify Oracle Configurator 
Enabled Values, page 2-26

Required Y N Section 2.5.16, 
page 2-26

32. Verify Instance Class 
Values, page 2-26

Required Y N Section 2.5.17, 
page 2-26

33. Verify Values for the 
Resubmit Interface Process, 
page 2-27

Required Y N Section 2.5.18, 
page 2-27
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Step 
Number

Title Required 
or 
Optional

Seeded
?

Extensible
?

Section 
Reference

34. Verify Values for CSI: 
Propagate Systems 
Changes, page 2-27

Required Y N Section 2.5.19, 
page 2-27

35. Set Up Regions for the 
Advanced Search Page, 
page 2-28

Optional Y N Section 2.5.20, 
page 2-28

36. Set Up the Results of the 
Search Item Instances Page, 
page 2-29

Optional Y N Section 2.5.21, 
page 2-29

37. Set Up Instance Statuses, 
page 2-32

Required Y Y Section 2.5.22, 
page 2-32

38. Set Up Source Transaction 
Types, page 2-34

Required Y Y Section 2.5.23, 
page 2-34

39. Set Up Transaction 
Subtypes, page 2-35

Required Y Y Section 2.5.24, 
page 2-35

40. Set Up the Transaction 
Subtypes LOV from 
Non-Service Processes, page
2-38

Required Y N Section 2.5.25, 
page 2-38

41. Verify Transaction Status 
Codes, page 2-39

Required Y N Section 2.5.26, 
page 2-39

42. Verify Transaction Error 
Source Types, page 2-39

Required Y N Section 2.5.27, 
page 2-39

43. Create Business Users, page
2-40

Required N N Section 2.5.28, 
page 2-40

44. Create Agent Users, page 2-
40

Required N N Section 2.5.29, 
page 2-40

45. Schedule the Expire End 
Dated Instances Program, 
page 2-41

Required N N Section 2.5.30, 
page 2-41
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Step 
Number

Title Required 
or 
Optional

Seeded
?

Extensible
?

Section 
Reference

46. Schedule the Install Base 
Open Interface Program, 
page 2-41

Required N N Section 2.5.31, 
page 2-41

47. Run the Initiate Mass 
Update Program, page 2-42

Required N N Section 2.5.32, 
page 2-42

48. Schedule the Process Old 
Order Lines-Fulfillable Only
Program, page 2-43

Required N N Section 2.5.33, 
page 2-43

49. Schedule the Resubmit 
Interface Process, page 2-44

Required N N Section 2.5.34, 
page 2-44

50. Schedule the Resubmit 
Waiting Transactions 
Program, page 2-44

Required N N Section 2.5.35, 
page 2-44

51. Schedule the Install Base 
and Inventory Data 
Discrepancies Program, 
page 2-45

Required N N Section 2.5.36, 
page 2-45

52. Schedule the Install Base 
Error Correction and 
Synchronization Program, 
page 2-46

Required N N Section 2.5.37, 
page 2-46

53. Final Synchronize On-Hand
Balance with Oracle 
Inventory, page 2-47

Required NA NA Section 2.5.38, 
page 2-47

Related Setup Steps within Other Oracle Applications

Synchronize On-Hand Balance with Oracle Inventory
To maintain life-cycle tracking for all items that are to be tracked in Oracle Installed 
Base, Oracle Installed Base maintains a mirror image of what is in Oracle Inventory. For 
new implementations of Oracle Installed Base, all on-hand quantities of Oracle Installed
Base trackable items must be issued out of Oracle Inventory. Oracle suggests that you 
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use the miscellaneous issue transaction in Inventory to do this step.

You receive these items back into Inventory at Step 53 in the checklist. Refer to 
Section 2.5.38, page 2-47 for related information.

Set Up Inventory Serial Control at the Master Level
Oracle Installed Base requires that the serial control of Oracle Installed Base trackable 
items is set up in the master organization for Oracle Installed Base to support the 
continuous tracking through all organizations. For instructions on how to do this, 
consult the Oracle Inventory User's Guide, Volumes 1 and 2.

Set Up Oracle Installed Base Items in the Item Master
All items that need to be tracked in Oracle Installed Base and Asset Tracking are set up 
as Oracle Installed Base trackable, whether they are tangible, inventory-transactable, 
shippable items such as a computer or intangible, non-inventory-transactable, 
non-shippable items such as a license. An item can be either Oracle Installed Base 
trackable or a service item such as a contract. It cannot be both. 

For an item to be set up as trackable in Oracle Installed Base, the Install Base Tracking 
checkbox must be selected on the Service tabbed page of the Master Item window. The 
navigation is Inventory > Items > Master Items. This item attribute must be controlled at
the master inventory organization level only.

To create a warranty for a item instance, the service item of the contract must be part of 
the BOM of the top assembly item. 

Instances can be created online and through interfaces such as Inventory receipt and 
WIP assembly completion. 

Refer to Section 1.3.1, "Integration with the Oracle E-Business Suite", page 1-6 for 
information about instance creation through integration.

For more information about how to set up items in Item Master, consult the Oracle 
Inventory User's Guide, Volumes 1 and 2.

Set Up Parties
The parties associated with item instances in Oracle Installed Base need to be defined in 
HZ_PARTIES first.

For more information about how to set up parties, consult the Oracle Accounts Receivable 
Implementation Guide

Set Up Vendors
The vendor parties associated with item instances in Oracle Installed Base need to be 
defined in PO_VENDORS first. For more information about how to set up vendors, 
consult Oracle Purchasing implementation guides.
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Set Up Employees
Employees can be associated with Oracle Installed Base item instances as parties. To do 
so, employees must be defined in HR tables first.

For more information about how to set up employees, consult Oracle Human Resources
Applications implementation guides.

Set Up Party Accounts
The parties associated with item instances in Oracle Installed Base can have a number of
accounts associated with them. These accounts need to be defined in the 
HZ_CUST_ACCOUNTS table before referencing them in Oracle Installed Base.

For more information about how to set up party accounts, consult the Oracle Accounts 
Receivable Implementation Guide.

Set Up Party Contacts
Oracle Installed Base can maintain the contacts to parties associated with item instances.
These contacts to parties must be defined in the HZ_PARTIES table using the Contact 
Center window before referencing them in Oracle Installed Base.

For more information about how to set up party contacts, consult the Oracle Accounts 
Receivable Implementation Guide.

Verify the Setup of the Oracle Service Fulfillment Event Manager Queue
For instructions on setting up the Oracle Service Fulfillment Event Manager Event 
Queue, refer to the Oracle Service Fulfillment Manager Implementation Guide. 

Oracle Installed Base is dependent on the SFM Event Manager Queue Service, 
specifically the Event Manager Queue, which must always be active.

Setup to Ensure the Serializability of Transactions Processed in Oracle Installed Base (One Time) 
At any one time several transactions originating from Inventory and Order 
Management can be processed in Oracle Installed Base. To eliminate the errors that can 
occur due to the concurrent execution of these transactions, the following steps must be 
performed to ensure the serializability of these transactions:

Steps

1. Log into Oracle Applications. 

2. Navigate to System Administrator > Concurrent > Manager > Define. 

3. Query for the Manager SFM Event Manager Queue Service. 
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4. Click Work Shifts.

5. Change the processes to 1. 

6. In the Parameter field, change the value of XDP_DQ_INIT_NUM_THREADS to 1. 

7. Stop and restart the SFM Event Manager Queue. 

Monitor SFM's Event Manager Queue Service (Daily Basis) 
If a DBA wants to check whether SFM's Event Manager Queue Service is running, this 
can be done from any of the following places: 

• SFM's Queue Console - this provides the status as well as the queue size. 

• Concurrent Manager's Administer Manager Form - this provides the status.

• Oracle Application Manager's SFM page - this page is in HTML. It allows a DBA to 
see the Event Manager Queue Service status and Queue Size. 

Set Up the Action Menu in Oracle Order Management
This menu setup is required so that Transaction Details and Maintain Systems windows
are set up as part of the Action menu.

Steps
1. Log on to Oracle Applications with the System Administrator responsibility.

2. Choose Applications > Menu.

3. Choose View > Query By Example > Enter.

4. In the Menu field, enter the string ONT_SALES_ORDERS.

5. Choose View > Query By Example > Run.

6. Go to the last record in the multi-record details block.

7. Choose File > New to create new records with the following Field Values:

1. Seq: Choose the next sequence.

2. Function: Select Installed Base Transaction Details from the list of values.

3. Seq: Choose the next sequence.

4. Function: Select IB Maintain Systems from the list of values.
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8. Save the record.

Set Up the Order Management Workflow for Non-Shippable Items
Oracle Installed Base creates instances when tangible items are received into inventory. 
It tracks tangible items, for example, as they move between locations in inventory, 
when they are shipped to customers, and when they are returned to an enterprise. 
Inventory is a key driver enabling Oracle Installed Base tracking of tangible items.

Tracking intangible items, which are non-shippable and non-stockable, requires a 
separate procedure because Oracle Installed Base has no direct interaction with 
inventory.

Generally, intangible or fulfillable items are created and tracked commencing with sales
order fulfillment. This requires integration with Oracle Order Management. The 
integration provides Oracle Installed Base with information regarding fulfilled sales 
order lines. The integration is achieved by modifying Oracle Order Management order 
line workflows. The information below provides detailed steps to accomplish the 
modification.

The following two main steps are required to modify order line workflows to enable 
Oracle Installed Base tracking for non-shippable items:

1. Set up Oracle Workflow Builder 

2. Set up Oracle Order Management transaction types 

Set Up Oracle Workflow Builder
The Workflow Builder setup is done in Oracle Workflow Builder. Use this procedure.

Steps
1. Log on to Oracle Workflow Builder on your client PC.

2. Double click the Workflow Builder icon. 

3. Select File > Open > Database.

4. Enter username apps, your apps password, and the connect string for your 
database instance.

5. Click OK.

6. Select OM Order Line from the Show Item Types window.

7. Click the << button to move to the Visible list, and click OK. The Navigator window
opens.

8. Expand the list in the Navigator window by clicking the + sign.
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9. Click OEOL / OM Order Line to select it.

Now you are ready to add a new function.

10. Choose Edit > New > Function from the menu. The Function Properties window 
appears.

11. Enter the following details in the Activity tabbed page:

• Internal Name: INSTALL_BASE_INTERFACE

• Display Name: Install Base Interface 

• Description: Oracle Installed Base interface for fulfillable order lines 

• Function Name: CSI_ORDER_FULFILL_PUB.FULFILL_WF

• Function Type: PL/SQL

• Result Type: <None>

12. In the Details tabbed page, ensure that values are set as follows: 

• Error Item Type: WFERROR

• Error Process: RETRY_ONLY

• On Revisit: Reset

13. Click OK.

Now you are ready to create a new process and assign the new function to the 
process.

14. Select Processes.

15. Right click the order line flow that you want to customize and choose Copy.

16. Right click again and choose Paste. This opens the Processes Properties window.

17. Enter a different Internal Name and Display Name for the newly created process, 
and click OK.

18. Double click the newly created process to open it.

19. Click the New Function icon on the top icon bar.

20. Click the Internal Name LOV, and choose INSTALL BASE INTERFACE.
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21. Delete the line after the Fulfill function. This line is the one going from Fulfill to the 
node after Fulfill.

22. Insert Install Base Interface after the Fulfill function.

23. Right click Fulfill, and drag it to Install Base Interface.

24. Right click Install Base Interface, and drag it to the node after Fulfill. For option 
results, choose Any.

25. Save your work and exit.

Note: This customization must be done for fulfill-only order line 
workflows. They are those without shipping activity as, for 
example, a Bill Only or Line Flow – ATO Model.

Note: The same process must be followed for return lines, which 
are those without a receipt activity in the order line workflow. The 
process is required for a non-shippable RMA interface to Oracle 
Installed Base as, for example, the seeded process Line Flow – 
Return for Credit Only.

Set Up Oracle Order Management Transaction Types
Use this procedure to set up the required transactions types in Oracle Order 
Management.

Steps
1. Using the Order Management Super User responsibility, navigate to Setups > 

Transaction Types.

2. Query the desired transaction types that you plan to use on the sales orders.

3. Click Assign Work Flows.

4. End date appropriate seeded line types using seeded workflows. 

5. Create another record with the same line type (expired record). 

6. Assign Modified Workflow process, for example, CSI Line Flow-Generic, created in 
Oracle Workflow Builder, to this line type.

7. Save your work and exit.
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Process Sales Orders for Non-Shippable Items
After the two main setup steps are complete, sales order lines using newly customized 
workflows have an interface to Oracle Installed Base. Use this procedure to process 
sales orders for non-shippable items.

Steps
1. Place an order for a non-shippable item through Oracle Order Management using 

the customized line type created in the previous section.

2. Book the sales order.

3. Schedule or run the Oracle Order Management Workflow background process. 

4. View the instance created in Oracle Installed Base.

Related Setup Steps within Oracle Asset Tracking

Run the License Manager Program
Run this program to license Oracle Asset Tracking only if you have not installed Oracle 
Asset Tracking. It enables Oracle Asset Tracking functionality for inventory receipts 
and other processing required for Oracle Installed Base.

Verify the Setup of Four Profile Options for Oracle Asset Tracking
This is required only if you have not installed Oracle Asset Tracking. Confirm that the 
following profile options were set up:

• MO: Operating Unit (default operating unit)

• CSE: Debug Option (Y or N)

• CSE Debug Log Directory (path name)

Verify Location IDs in HZ_LOCATIONS
The following table lists the locations that must be defined in the HZ_LOCATIONS 
table before using them in Oracle Installed Base:
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Locations that Must Be Defined in the HZ_LOCATIONS Table

Location Description

Project A fixed location ID defined for Projects in the 
HZ_LOCATIONS table.

WIP A fixed location ID defined for WIP in the 
HZ_LOCATIONS table.

IN_TRANSIT A fixed location ID defined for In-transit in the
HZ_LOCATIONS table.

PO A fixed location ID defined for PO in the 
HZ_LOCATIONS table.

These fixed location IDs must be defined in HZ_LOCATIONS first before setting up the 
Installation Parameters in a later step. To set up locations, do the following:

1. Using the Oracle Installed Base Admin responsibility, navigate to Setups > Maintain
Locations. The HZ Locations window appears.

2. Set up locations in this window.

Verify Codes for Asset Update Statuses
Type: CSI Lookup

Lookup Type: CSI_ASSET_UPDATE_STATUS

Access Level: System (non-extensible)

Verify that the following values that are shown in the following table are already 
seeded for CSI_ASSET_UPDATE_STATUS.

Seeded Values for CSI_ASSET_UPDATE_STATUS

Lookup Code Meaning Description

IN-SERVICE In-Service In-Service

RETIRED Retired Retired

Refer to the Oracle Asset Tracking Implementation Guide for details.
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Setup Steps within Oracle Installed Base
Most of these steps are performed through navigation to Oracle Installed Base Setups 
and Lookups. You access these through the Oracle Installed Base Admin responsibility. 
Online help for the Installed Base Lookups window provides information about 
lookups. The menu options for the Oracle Installed Base Admin user include the 
following entries:

• Transaction Errors Processing

• Open Interface Error Details

• Lookups

• Setups

• Install Parameters

• Instance Relation Types

• Party Account Relation Types

• Transaction Subtypes

• Source Transaction Types

• Extended Attribute Template

• Instance Statuses

• Asset Location Setup

• Maintain Locations

• Counter Property Type

• Others

• Requests

• Reports

Set Up Installation Parameters
Oracle Installed Base keeps a set of customer-specific installation parameters defined in 
a table at setup time. You use the Installed Parameters window to provide them. After 
you define them and select Freeze, the fields cannot be updated. 
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The migration procedure populates the table with default data. After migration, you 
open the window for update before the freeze takes effect. 

Oracle Installed Base Admin responsibility: Setups > Install Parameters

The following list defines the fields in the Installed Parameters window.

• Party Name: The name of your own enterprise that you define in TCA as an 
internal organization. It is the owner of the item instance when it is owned by your 
own enterprise. Item transfers from this party are not supported. The organization 
cannot be changed after it is set.

For new Oracle Installed Base customers, this party can be first set up as an internal 
party using Contact Center from the Oracle Customer Support application. This 
party does not require an account number. This HZ_PARTY can then be used in the
Party Name field in the Install Base Parameter setup. 

In the case of upgrades, this setup is done by setting the profile option Service: 
Migration Organization for Employee Service Requests. This profile option setting 
is only used during the upgrade process to populate the Party Name field in the 
Install Parameters window. After the upgrade is complete, all functionality refers to
the value in the Party Name field of the Install Parameters window and not to the 
profile option. For example: You buy and receive an item in Oracle Receiving. The 
Oracle Installed Base process that creates the item instance assigns ownership of 
this new instance based on the Party Name in the Install Parameters window. 

Note: Do not use this party as the object of a merge in TCA merge 
routines.

• Full Dump Frequency: The number of updates of an Oracle Installed Base record 
before a full image of the record is dumped into the history table. For example, 
HISTORY_FULL_DUMP_FREQUENCY=10 means that every 10th update made to 
a record in any Oracle Installed Base table is followed by a complete dump of 
record's image (changed as well as unchanged columns) in the corresponding 
history table. For the remaining nine updates, only the changed values are dumped 
into the history table.

• Category Set Name: The name of the category set to be used in the additional 
attributes setup.

• Create Unique Asset For: For all transactions that create an asset, this determines if 
there is a separate asset for each serialized instance or one asset for all serialized 
instances.

• All Parties: If selected, then all parties and locations are made available for transfer 
and location change. If it is not selected, then only related parties and locations are 
made available for transfer and location changes.
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• Freeze: After this is selected, the parameters cannot be changed.

• Allocate at WIP: If selected, conditionally allocates component quantities when 
completing a multi-quantity assembly WIP job.

Some of the general conditions governing multi-quantity WIP assembly completion 
configurations include:

• Configurations are built based on job requirements.

• Configurations are only built for assemblies serialized at receipt or predefined.

• If genealogy is enabled, configurations are created according to genealogy or 
from the parent serial number.

• Override Ownership: If selected, allows Oracle Installed Base processing of RMA 
receipts, order shipment, and miscellaneous receipts regardless of ownership.

For example: 

In the case of an RMA receipt, Oracle Installed Base processes the request even if 
the RMA customer is different from existing instance ownership. Oracle Installed 
Base changes ownership to the RMA customer if the transaction subtype's Change 
Owner To field is null.

For a miscellaneous receipt (serialized at-receipt or predefined) of an existing 
Oracle Installed Base instance, the ownership changes to Internal.

Note: By default, the Override Ownership checkbox is not selected. 
After you select it and save one or more transactions, never attempt 
to change it because doing so results in irrecoverable data 
corruption.

• SFM Bypass: Replaces the previous CSE: Bypass Event Queue profile option.

Note: Do not select this checkbox. The selected state is reserved for 
internal testing purposes and is not recommended. For further 
information, refer to the Oracle Asset Tracking Implementation Guide.

• Force Cascade Ownership to Components: Whenever ownership of an item 
instance changes for a parent instance, selecting this option causes the application 
to cascade ownership of the parent to component children in a configuration for 
outbound transactions such as Shipment. 

This value becomes the default for the Cascade Ownership field in the Source 
Transaction Details tab of the Order Management Transaction Details window. You
can override the value in that window.
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Set Up Codes for Party-Account and Party-Contact Relationship Types
The instance party account relationship codes define the types of relationship that can 
be set up for parties, accounts, and contacts. The six seeded relationship types are 
defined in the following table:

Seeded Relationship Types

Name Party Selected? Account Selected? Contact Selected?

OWNER Y Y N

BILL-TO Y Y Y

SHIP-TO Y Y Y

SOLD-TO Y Y N

TECHNICAL N N Y

SERVICE-ADMINIST
RATION

N N Y

You can set up additional relationship type codes for party, account, and contact and 
define them by selecting the appropriate Party, Account, and Contact checkboxes in the 
Instance Party Account Relationship Types window.

For more information about setting up these codes, consult the Oracle TeleService 
Implementation Guide.
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Verify Codes for Instance Relationship Types
Oracle Installed Base supports the eight types of instance-to-instance relationships 
shown in the following table:

Relationship Type Codes

RELATIONSHIP TYPE 
CODE

NAME RELATIONSHIP DIRECTION

COMPONENT-OF Component Of Subject-to-Object

MEMBER-OF Member Of Subject-to-Object

PROVIDED-BY Provided By Subject-to-Object

INSTALLED-ON Installed On Subject-to-Object

CONNECTED-TO Connected To Bi-directional

UPGRADED-FROM Upgraded From Subject-to-Object

REPLACEMENT-FOR [for 
transaction only]

Replacement For Subject-to-Object

REPLACED-BY [for 
transaction only]

Replaced By Subject-to-Object

Component-of is the only relationship type that supports the flow-down of the current 
location and the installation location from parent to child. 

From the Oracle Order Management-Oracle Installed Base shipment/fulfillment 
integration, component-of configuration can be created through the BOM explosion, 
PTO model, and ATO model. For details, see the topic Oracle Order Management 
Integration in the Oracle Installed Base Implementation Guide.

From the WIP-Oracle Installed Base integration, component-of configuration can be 
created through the WIP assembly completion into inventory. For details, see the topic 
WIP Integration in the Oracle Installed Base Implementation Guide.

Replaced-by and replacement-for relationship types are created only by the Oracle 
Order Management-Oracle Installed Base integration using the Transaction Details 
window. They are set up as transaction only. For further information, refer to 
"Using the Order Management Transaction Details Window" in Oracle Installed Base User
Guide.
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All other relationship types can be used in setting up multiple relationship types for the 
same instance. No location flow-down rules apply. 

Verify that the standard instance statuses are seeded by checking the content of the 
Instance-Instance Relation Type Codes window.

Verify Extended Attribute-Level Codes
Type: CSI Lookup

Lookup Type: CSI_IEA_LEVEL_CODE

Access Level: System (non-extensible)

Use the following table to verify that the indicated values are already seeded for 
CSI_IEA_LEVEL_CODE. The table describes the four levels of extended attributes that 
you can define for Oracle Installed Base items. These are the extended attributes that are
used in the Extended Attribute page of the application.

Lookup Code Meaning Description

GLOBAL Global Applicable to all item 
instances in Oracle Installed 
Base

CATEGORY Category Applicable to the items of the 
category for which the 
extended attributes are 
defined

ITEM Item Applicable to all instances of 
the item type for which the 
extended attribute is defined.

INSTANCE Instance Applicable only to the 
instance for which the 
extended attribute is defined.

Use the Install Base Lookups window to verify that these codes are seeded for type 
CSI_IEA_LEVEL_CODE. 

Set Up Extended Attribute Pools
Type: CSI Lookup

Lookup Type: CSI_EXTEND_ATTRIB_POOL

Access Level: Extensible
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Values are not seeded for this code.

Optionally define extended attribute pools with code values such as color and grade.

To set up extended attributes, the name and code of the attribute have to be set up in 
the pool of attributes. This is where users can define an attribute's name, code, and 
description to be used in the LOV when the extended attribute is set up.

Set Up Extended Attribute Classifications
Type: CSI Lookup

Lookup Type: CSI_IEA_CATEGORY

Access Level: Extensible

Values are not seeded for this code.

Optionally define extended attribute classifications such as chemical and physical.

To set up extended attribute classifications, the name and code of the attribute have to 
be set up in the pool of attributes (see Section 2.5.5, page 2-20). Then each attribute can 
be classified into category. This is the table to define the categories by which an 
attribute can be classified from a LOV in the extended attribute setup.

Set Up Extended Attributes
The extended attributes used for Oracle Installed Base item instances must be defined in
the Extended Attributes window. 

Four levels of extended attributes can be defined for Oracle Installed Base items:

• Global: Global Level Extended Attributes are applicable to all the item instances in 
Oracle Installed Base.

• Item Category: Category level extended attributes are applicable to the items of the 
category for which the extended attributes are defined.

• Inventory Item: Item level extended attributes are applicable to all the instances of 
the item type for which the extended attribute is defined.

• Instance: Instance level extended attributes are applicable only to the instance for 
which the extended attribute is defined.

Use the Oracle Installed Base Extended Attributes window to define these attributes.

Verify Accounting Classification Codes
Type: CSI Lookup

Lookup Type: CSI_ACCOUNTING_CLASS_CODE

Access Level: System (non-extensible)
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Verify that the following values shown in the following table are already seeded for 
CSI_ACCOUNTING_CLASS_CODE.

Accounting Classification Codes

Lookup Code Meaning Description

INV Inventory Inventory

ASSET Asset Asset

WIP Work In Process Work In Process

PROJECT Project Project

CUST_PROD Customer Product Customer Product

Set Up Instance Type Codes
Type: CSI Lookup

Lookup Type: CSI_INST_TYPE_CODE

Access Level: Extensible

No values are seeded for CSI_INST_TYPE_CODE.

Define the instance type codes used by your organization. You can enter any value. 
Examples of instance types are Hardware, Software, and Service. This code is an 
optional classification for an instance and is used in the general attributes page in the 
application. 

Verify Codes for Instance Location Sources
Type: CSI Lookup

Lookup Type: CSI_INST_LOCATION_SOURCE_CODE

Access Level: System (non-extensible)

Verify that the values in the following table are already seeded for 
CSI_INST_LOCATION_SOURCE_CODE.
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Instance Location Source Codes

Lookup Code Meaning Description

HZ_LOCATIONS HZ Location The Location is defined in the 
HZ_LOCATIONS table.

HZ_PARTY_SITES HZ Party Site Item is at an external party 
site. The location is defined in 
the HZ_PARTY_SITES table.

INTERNAL_SITE Internal Site Item is at an internal site. The 
location is defined in 
HR_LOCATIONS table.

INVENTORY Inventory Item is in inventory.

IN_TRANSIT In-Transit Item is in Transit. Location is 
defined by in-transit order 
line ID.

PO PO Location is defined in 
PO_LINES_ALL table.

WIP Work in Process Item is in WIP.

PROJECT Project Item is in Project.

VENDOR_SITE Vendor Site Item is at a vendor site. 
Location is defined in 
PO_VENDOR_SITES_ALL 
table.

These are the types of product locations that are supported in Oracle Installed Base.

Verify Party Sources
Type: CSI Lookup

Lookup Type: CSI_PARTY_SOURCE_TABLE

Access Level: System (non-extensible)

Verify that the values in the following table are already seeded for 
CSI_PARTY_SOURCE_TABLE.
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Party Sources Codes

Lookup Code Meaning Description

HZ_PARTIES HZ_PARTIES Party is defined in 
HZ_PARTIES table.

PO_VENDORS PO_VENDORS Party is defined in 
PO_VENDORS table.

EMPLOYEE HR Employee Party is defined in Party is 
defined in 
PER_ALL_PEOPLE_F table.

This table is not extensible. It defines the types of parties that are supported in Oracle 
Installed Base for an instance. For example, an owner can be a party (such as a 
customer), an employee, or a vendor. A party that provides support can be a team or a 
group.

Set Up Codes for Instance-Operating Unit Relationship Types
Type: CSI Lookup

Lookup Type: CSI_IO_RELATIONSHIP_TYPE_CODE

Access Level: Extensible

Verify that the values in the following table are already seeded for 
CSI_IO_RELATIONSHIP_TYPE_CODE.

Codes for Instance-Operating Unit Relationship Types 

Lookup Code Meaning Description

SOLD_FROM Sold from The item is sold from this 
operating unit.

SERVICE_BILL_FROM Service billed from The operating unit that gets 
the credit from Billing.

Define new instance-to-operating units codes specific to your organization. Oracle 
Installed Base has limited functionality behind this instance-operating unit association. 
It is for information only. The SOLD-FROM relationship is created each time an 
instance is sold from an operating unit.
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Set Up Version Labels
Type: CSI Lookup

Lookup Type: CSI_INSTANCE_VERSION_LABELS

Access Level: Extensible

Verify that the values in the following table are already seeded for 
CSI_INSTANCE_VERSION_LABELS.

Setup of Version Labels

Lookup Code Meaning Description

AS-CREATED As-Created As-Created

AS-MAINTAINED As-Maintained As-Maintained

AS-ORDERED As-Ordered As-Ordered

Define new version label codes to be used in your organization. This table of codes is 
used as a source of the LOV for the profile option setup in Default Version Label. It is 
used as a default when an instance is first created. 

Set Up System Type Codes
Type: CSI Lookup

Lookup Type: CSI_SYSTEM_TYPE

Access Level: Extensible

When a system is created, a type can be selected from an LOV. This table is where 
user-defined system types can be set up for use in the LOV.

Use the setup window to define system types for your organization. They are used in 
the Systems page of the application to define systems.

Set Up Split Process Reasons
Type: CSI Lookup

Lookup Type: CSI_SPLIT_REASON_CODE

Access Level: User (Extensible)

No values are seeded for CSI_SPLIT_REASON_CODE

Define split reasons to be used in your organization.
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When an instance with a quantity greater than 1 is split, a reason code can be selected 
for the reason for the split. This is the window where the reason codes can be set up for 
use in an LOV.

Verify Oracle Configurator Enabled Values
Type: CSI Lookup

Lookup Type: CSI_CONFIG_ENABLED_VALUES

Access Level: System (Non-Extensible)

This setup maintains the LOV for the profile option CSI: Configurator Enabled and is 
used for integration with the Oracle Telecommunications Service Ordering solution and
the Oracle Configurator product. Values are system defined and seeded.

Verify that the values in the following table are already seeded for 
CSI_CONFIG_ENABLED_VALUES.

Codes for Oracle Configurator Enabled Values

Lookup Code Meaning Description

NETWORK Network Models Only Network Models Only

NEVER Never Never

Verify Instance Class Values
Type: CSI Lookup

Lookup Type: CSI_ITEM_CLASS

Access Level: System (Non-Extensible)

This setup maintains the LOV for the Instance Class field in the Service tab in the 
Inventory Item setup. It is used for integration with the Oracle Telecommunications 
Service Ordering solution and Oracle Configurator.

Confirm that the values in the following table are seeded for CSI_ITEM_CLASS.
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Codes for Instance Classes

Lookup Code Meaning Description

LINK Link Items of this class are used to 
connect two other item 
instances in Oracle Installed 
Base.

Verify Values for the Resubmit Interface Process
Type: CSI Lookup

Lookup Type: CSI_RESUBMIT_OPTIONS

Access Level: System (Non-Extensible)

This setup maintains the LOV for the Oracle Installed Base concurrent request Resubmit
Interface process. 

Confirm that the values in the following table are seeded for 
CSI_RESUBMIT_OPTIONS.

Codes for Resubmit Interface Options

Lookup Code Meaning Description

ALL All All transactions

SELECTED Selected Selected transactions from the
Error Re-Processing window.

Verify Values for CSI: Propagate Systems Changes
Type: CSI Lookup

Lookup Type: CSI_SYSTEM_WINDOW_DISPLAY

Access Level: System (non-extensible)

This setup maintains the LOV for the profile option CSI: Propagate Systems Changes - 
Window Display. The Maintain System window uses these values when displaying a 
confirmation window.

Confirm that the values in the following table are seeded for 
CSI_SYSTEM_WINDOW_DISPLAY.
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Codes for CSI: Propagate Systems Changes

Lookup Code Meaning Description

DISPLAY Always display Always display

NO_DISPLAY-ALWAYS_CH
ANGE

Do not display and always 
change

Do not display and always 
change

NO_DISPLAY_NEVER_CHA
NGE

Do not display and do not 
change.

Do not display and do not 
change.

Set Up Regions for the Advanced Search Page
Type: CSI Lookup

Lookup Type: CSI_ADV_SEARCH_DEF_SHOW

Access Level: System (Non-Extensible)

Navigation: Unlike the case for most other CSI lookups, you must use the Application 
Developer responsibility to navigate to Application Lookups > Application Object 
Library. The Application Object Library Lookups window appears.

This setup lists regions that are shown by default in the Advanced Search page. At the 
site level, customize the display of that page by removing or collapsing regions as 
required.

Steps
1. Use the following table to confirm the seeded values for 

CSI_ADV_SEARCH_DEF_SHOW.

Codes for the Advanced Search Page

Lookup Code Meaning Description

00100 CSI_GEN_ATTR CSI_SHOW

00200 CSI_PARTY CSI_SHOW

00300 CSI_PARTY_ACCOUNTS CSI_HIDE
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Lookup Code Meaning Description

00400 CSI_CURRENT_LOCATIO
N

CSI_SHOW

00500 CSI_INSTALLED_AT CSI_HIDE

00600 CSI_PARTY_CONTACT CSI_HIDE

00700 CSI_ORDERS CSI_HIDE

00800 CSI_ASSETS CSI_HIDE

00900 CSI_CONTRACT CSI_HIDE

01000 CSI_OTHER_INFO CSI_HIDE

2. Use the To column in the Effective Dates region to exclude a section from being 
displayed in the Advanced Search page.

3. Indicate whether a remaining section appears in expanded mode by default by 
entering CSI_SHOW (all uppercase) in its Description column. Otherwise the 
section is collapsed on the Advanced Search page.

Set Up the Results of the Search Item Instances Page
Type: CSI Lookup

Lookup Type: CSI_PRODUCTS_TABLE_DEF_COLS

Access Level: System (Non-Extensible)

Navigation: Unlike the case for most other CSI lookups, here you must use the 
Application Developer responsibility to navigate to Application Lookups > Application 
Object Library. The Application Object Library Lookups window appears.

This setup customizes the display of the search results of the Search Products page by 
indicating the display and order of viewable columns. (The result is stored internally in 
the Product Search Results table.) The setup window shows the enabled columns of the 
corresponding search results with their left-to-right order indicated by their Description
value.

Here are some definitions that explain how to use the window:

• The Meaning column lists the prompt IDs of all column titles of the search results. 
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• Use the To column in the Effective Dates region to exclude a column from being 
displayed by default in the search results. For example, if by default you do not 
want to display Usage in the search results, then end date the corresponding row in 
the lookup to exclude that column. 

• The Description column contains a numeric value that indicates the relative order of
a column in the search results. A column with a smaller number appears to the left 
of a column with a bigger number. For example, if you set the Description value for 
the Status column to 50 compared to 70 for the Quantity column, then Status 
appears to the left of Quantity in the search results. 

• The To date, an end date, is of primary importance. Thus, if a a row is end dated, 
then the Description value is disregarded.

• The lookup does not affect the Item Description column, which always appears as 
the leftmost column.

The following table lists the codes that are available to set up the results of the Search 
Products page.

Lookup Code Meaning Description

0010 CSI_ITEMNUM 10

0015 CSI_ITEMTYPE 15

0020 CSI_INSTANCE_NUMBER 20

0030 CSI_SERIALNUM 30

0040 CSI_LOTNUM 40

0050 CSI_SYSTEM 50

0060 CSI_SYS_OP_UNIT 60

0070 CSI_TAG_NUMBER 70

0080 CSI_STATUS 80

0090 CSI_QUANTITY 90

0100 CSI_PRODUCT_TYPE 100
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Lookup Code Meaning Description

0110 CSI_RETURN_BY_DATE 110

0120 CSI_ACTUAL_RETURN_DA
TE

120

0125 CSI_SHIPPED_DATE 125

0130 CSI_USAGE 130

0140 CSI_SALES_ORDER_NUM 140

0150 CSI_SALES_ORDER_LINE 150

0160 CSI_SALES_ORDER_DATE 160

0170 CSI_PURCHASE_ORDER_N
UM

170

0180 CSI_AGREEMENT_NAME 180

0190 CSI_INSTANCE_START_DA
TE

190

0200 CSI_INSTANCE_END_DATE 200

0210 CSI_OWNER_PARTY_NAM
E

210

0220 CSI_OWNER_PARTY_NUM
BER

220

0230 CSI_OWNER_ACCT_NAME 230

0240 CSI_OWNER_ACCT_NUMB
ER

240

0250 CSI_INSTALLED_AT_LINE1 250

0260 CSI_INSTALLED_AT_LINE2 260

0270 CSI_INSTALLED_AT_LINE3 270
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Lookup Code Meaning Description

0280 CSI_INSTALLED_AT_LINE4 280

0290 CSI_INSTALLED_AT_CITY 290

0300 CSI_INSTALLED_AT_STATE 300

0310 CSI_INSTALLED_AT_POST
ALCODE

310

0320 CSI_INSTALLED_AT_COUN
TRY

320

0330 CSI_VIEW_DETAILS 330

0340 CSI_VIEW_CONFIG 340

0350 CSI_ALL_DETAILS 350

0360 CSI_COPY_PRODUCT 360

Set Up Instance Statuses
Instance statuses are user-extensible and are defined using a combination of settable 
checkboxes. The following table lists the seeded statuses.

Name Terminate
d

Status 
Change 
Allowed

Service 
Allowed

Requests 
Allowed

Pre-Define
d

Updatable

Created N Y Y Y Y N 

Expired Y Y N N Y N

Latest N Y Y Y Y N 

Loaner N Y N Y Y N

Repaired N Y Y Y Y N
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Name Terminate
d

Status 
Change 
Allowed

Service 
Allowed

Requests 
Allowed

Pre-Define
d

Updatable

Replaced N N N N Y N 

Replaced - 
No Return

Y Y N N Y N

Replaceme
nt

N Y Y Y Y N

Return for 
Replaceme
nt

Y Y N N Y N

Returned 
for Credit

N Y N N Y N

Returned 
for Repair

N Y Y N Y N

Returned 
for 
Upgrade

N Y Y N Y N 

Returned 
Loaner

N Y N N Y N

Spare Part N Y Y Y Y N

Updated N Y Y Y Y N

Upgraded N Y Y Y Y N

The meaning of the check boxes is as follows:

• Terminated: Sets the instance to be terminated.

• Status Change Allowed: The status can be changed for an instance currently bearing
this status.

• Service Allowed: Service contract can be active for the instance with this status. If 
set to No, then no further service contracts can be created for an item instance with 
this status.
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• Requests Allowed: Service request can be created for an instance with this status.

• Pre-Defined: Seeded

• Updatable: The checkboxes on this status can be updated

When you define your own instance statuses, you must set Pre-Defined to N and 
Updatable to Y.

Set Up Source Transaction Types
Before any source transaction can be used in the LOV for a transaction subtype, it must 
be defined in this setup in the Source Transaction Types window. All integration 
sources and transaction types must be defined here before they can be used to update 
Oracle Installed Base. Values can be seeded or user-defined. See Section 2.5.24, page 2-
35 for the setup of the transaction subtypes displayed in this window. 

Window Fields in the Source Transaction Types Region
Application Name: An LOV of Oracle Applications that can be set up to integrate into 
Oracle Installed Base.

Transaction Type: The user-defined name of the kind of transaction that integrates with 
Oracle Installed Base from the application named. 

Transaction Name: The user-defined name of the transaction.

Description: The user-defined description of the transaction.

Source Object: Reserved for future use.

In Out: Reserved for future use.
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Set Up Transaction Subtypes
Transaction types and subtypes are used to specify the kinds of transactions that the 
interface program can use. The main purpose of the Source Transactions Subtypes 
window is to specify what kind of update can be done to an Oracle Installed Base 
instance when transactions come from other applications. In Oracle Order Management 
you can go into the transaction details to pick one of the transactions being defined 
here. Here you define these transactions and the kind of actions they can perform on the
source instance and the non-source instance.
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Transaction Subtypes Region
This region is used to define the name of the transaction subtype. The name can come 
form two sources, depending whether the Service Type checkbox is selected or not:

• If Service Type is selected, then the LOV comes from the Service Transaction Billing 
Types setup. 

• If Service Type is not selected, then the LOV comes from the Oracle Installed Base 
Transaction Type code setup. Refer to the section on "Transaction Subtype from the 
Non-Service process." 

The Name field provides the LOV from which you can select the name of the 
transaction subtype.

Source Info Region
This region is used to define the specific actions to take for the instance being 
transacted. In the case of the sales order line, it can the part being sold on the sales order
line. 

Reference Required: Specifies whether an Oracle Installed Base item instance number or
reference number is mandated for this transaction type. In the case of a return of a 
non-serialized item, this Oracle Installed Base item instance number is always required 
for the Oracle Installed Base interface to know which instance to update. If the part is a 
serialized item, then this item instance number is not mandated because the interface 
program can pick up the serial number from the receipt transaction.

Change Owner: Indicates whether a change of ownership is to take place for this 
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transaction type. If checked, then a change of ownership is to take place.

Change Owner To: Selects the ownership change to be Internal or External. For 
example, when returning an item for repair, the ownership need not be changed. For a 
sales order of a shipped item, the ownership can be changed to External.

Status: Defines the status to be updated for this instance. For example, when an instance
is returned for repair, its status is changed to Returned for Repair.

Return Reqd: Requires a return date to be entered on the Installation detail for this 
transaction. Not mandatory.

Revision Reqd: Requires a revision to be entered on the Installation detail for a revision 
controlled instance. Not mandatory.

Non Source Info Region
This region is to define the specific actions to make for the instance being related to the 
instance being transacted. 

The action to be taken for the non-source instance comes from this region. For example, 
in order to use this subtype for a to-be-replaced instance in the non-source installation 
detail, Reference Reqd must be selected, and a status specified. 

Reference Reqd: Specifies whether an Oracle Installed Base item instance number or 
reference number is mandated for this transaction type. 

Change Owner: Indicates whether a change of ownership is to occur for this transaction 
type. If checked, then change of ownership is to occur.

Change Owner To: Selects the ownership change to be Internal or External. 

Status: Defines the status to be updated for this instance. For example, the status of a 
replaced instance can be Replaced.

Return Required: Requires a return date to be input on the transaction detail for this 
transaction. 

Parent Info Region
This region is for future use. Thus, the Reference Reqd, Status, and Revision Reqd fields 
are not currently used.

Transaction Subtypes Region
The tab ordering of the fields in the window now returns to this region to the Freeze 
and Seeded checkboxes.

Source Transaction Types Region
This region is to define the source application from which the transaction being defined 
comes.

This is a LOV of transaction types defined first in the Source Transaction Type setup. 
For example, the Sell transaction subtype comes from the Oracle Order Management 
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application OM_SHIPMENT. Return for Credit comes from the Oracle Order 
Management application RMA_RECEIPT type.

Other examples of application sources are Oracle Field Service and Oracle Order 
Capture.

The In Out field is not being used for this release.

Default: Indicates whether this transaction subtype is to be used as the default subtype 
for that source transaction type and application being defined. For example, Sell is the 
default subtype for OM_SHIPMENT/ Order Management Ship/Fulfill sales order lines. 
Return for Repair is the default subtype for the RMA_RECEIPT/ Order Management 
Return line.

Update IB: Indicates whether this subtype/source transaction type combination is used 
to update Oracle Installed Base or not. For example, some subtypes set up for the Oracle
Field Service application updates Oracle Installed Base only from Oracle Field Service.

Set Up the Transaction Subtypes LOV from Non-Service Processes
Type: CSI Lookup

Lookup Type: CSI_IB_TXN_TYPE_CODE

If the Service Type checkbox of the Source Transactions Subtypes window is not 
selected, then the LOV comes from the Oracle Installed Base Transaction Type Codes 
setup. 

This setup is found in the Oracle Installed Base Administrator /Lookup/ 
CSI_IB_TXN_TYPE_CODE table. Six seeded values are used in the transaction subtype 
setup, and more can be user-defined. 

Use the following table to confirm the seeded values for CSI_IB_TXN_TYPE_CODE.

Lookup Code Meaning Description

ADD Add Add

FULFILL Fulfill Fulfill

ISSUE Issue Issue

MOVE Move Move

RECEIVE Receive Receive

SELL Sell Sell
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Verify Transaction Status Codes
Type: CSI Lookup

Lookup Type: CSI_TRANSACTION_STATUS_CODE

Access Level: System

Values are seeded for this code.

Use the following table to confirm the seeded values for CSI_IB_TXN_TYPE_CODE.

Lookup Code Meaning Description

COMPLETE Complete No further FA/PA processing

INTERFACED Interfaced to PA PA transaction interfaced

PENDING Pending Need further FA/PA 
processing

Verify Transaction Error Source Types
Type: CSI Lookup

Lookup Type: CSI_TXN_ERRORS_SOURCE_TYPES

Access Level: System

Values are seeded for this code.

When an integration transaction is processed with an error, it is posted to the error table
with one of the these error source types, which indicate where an error comes from.

Use the following table to confirm the seeded values for 
CSI_TXN_ERRORS_SOURCE_TYPES.

Lookup Code Meaning Description

AP_INVOICE_DISTRIBUTIO
NS_ALL

AP Invoice Distribution All For the AP invoice 
distribution events.

EIB_NOTIFICATIONS EIB Notifications Indicates that the message is a
notification generated by 
Oracle Asset Tracking during 
transaction processing.
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Lookup Code Meaning Description

FA_RETIREMENTS FA Retirements For the asset retirement and 
asset reinstatement events.

MIL_MATERIAL_TRANSAC
TIONS

MIL Material Transactions For all inventory-related 
events.

RCV_TRANSACTIONS RCV Transactions For the purchase order 
received into project event.

WFM_TRANSACTIONS WFM Transactions For all workforce 
management related events 
including equipment 
installed, equipment in 
service, asset in service, asset 
out of service, and item move.

Create Business Users
Create business users as needed for Oracle Installed Base. To do so, you must create 
business users and assign them the responsibility of an Oracle Installed Base customer 
and the predefined role of CSI_END_USER, CSI_READ_ONLY_USER, or 
CSI_CUSTOMER_USER. A role is a combination of permissions, which enable specific 
access and update privileges. For descriptions of the roles and permissions that Oracle 
Installed Base supports, see the topic Roles and Permissions in the appendix Seeded 
Data of the Oracle Installed Base Implementation Guide.

. For details on creating users and assigning associated accounts, roles, and 
responsibilities, refer to the user management sections of the Oracle Common Application 
Components User's Guide.

To confirm your user management work, log in to the Oracle E-Business Suite login 
(jtflogin) with the user name and password that you established, and everything should
be set. The accounts that you assigned should be what appear as the list of accounts 
associated with this user in the customer UI. It may be a subset because JTF shows all 
accounts regardless of active or inactive status whereas the Oracle Installed Base 
window shows only the active accounts that are associated with a user.

Create Agent Users
Create agent users as needed for Oracle Installed Base. To do so, you must create 
internal users and assign them the predefined CSI_NORMAL_USER role and the 
responsibility of an Oracle Installed Base user. A role is a combination of permissions, 
which enable specific access and update privileges. For more information, see the topic 
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Roles and Permissions in the appendix Seeded Data of the Oracle Installed Base 
Implementation Guide. For details on creating users and assigning associated accounts, 
roles, and responsibilities, refer to the user management sections of the Oracle Common 
Application Components User's Guide.

To confirm your user management work, log in to the Oracle E-Business Suite login 
(jtflogin) with the user name and password that you established, and everything should
be set.

Schedule the Expire End Dated Instances Program
This program goes through the end dates set up for instances to be expired. If the end 
date is past due, then the instances are set to expire. Schedule this program to run at 
least once a day:

Steps
1. Login as Oracle Installed Base Admin in the Forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Expire End Dated Instances.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

Schedule the Install Base Open Interface Program
This program imports significant volumes of data into Oracle Installed Base application 
tables through its mass load feature. Through its incremental load feature, it 
synchronizes Oracle Installed Base with subsystems by importing item instances from 
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different feeder systems on a frequent, on-going basis. Through its change functionality,
it automates the process of adding as well as updating changes to the attributes of item 
instances. It also validates imported data to ensure data integrity with Oracle 
applications. 

Steps
1. Login as Oracle Installed Base Admin in the Forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select either Install Base Open Interface or Install Base Open 
Interface - Parallel Concurrent Workers.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

Run the Initiate Mass Update Program
This is the program that is called automatically to run the mass update sessions. 
Schedule it to run at a regular interval to pick up mass update sessions due to be 
processed. To schedule the program:

Steps
1. Login as Oracle Installed Base Admin in the Forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.
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3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Initiate Mass update.

5. If you want to run a single batch only, enter the Batch Name as a parameter; if you 
leave the Batch Name blank, the concurrent request will run all waiting batches.

6. Click OK.

7. In the At these Times region, click Schedule.

The Schedule window appears.

8. Select the desired running schedule.

9. Click OK.

The Installed Base Requests window appears.

10. Click Submit.

Schedule the Process Old Order Lines-Fulfillable Only Program
This program processes the old fulfillable order lines migrated from previous versions 
of Oracle Installed Base. Run it once or twice a day for the month after you migrate. To 
schedule the program:

Steps
1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Process Old Order Lines-Fulfillable Only.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.
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7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

Schedule the Resubmit Interface Process
This program processes the transactions in the Error processing table. It can be set up to 
process selected lines or all lines in the table. This program can be called to run by user 
request or can set up to run at a regular interval. To schedule the program:

Steps
1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Resubmit Interface Process.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

Schedule the Resubmit Waiting Transactions Program
This program processes the transactions that are set as waiting status in the Oracle 
Installed Base update process. The program can be scheduled to run at a regular 
interval. To schedule the program:
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Steps
1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Resubmit Waiting Transactions.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window apears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

Schedule the Install Base and Inventory Data Discrepancies Program
The Install Base and Inventory Data Discrepancies program picks up the discrepancy 
data from the tables of Oracle Installed Base and Oracle Inventory and displays it on a 
report. The program can be scheduled to run at a regular interval. To schedule the 
program:

Steps
1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Install Base and Inventory Data Discrepancies.
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5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

Schedule the Install Base Error Correction and Synchronization Program
The Install Base Error Correction and Synchronization program is a concurrent program
to correct and reprocess the transactions that failed to update item instances in Oracle 
Installed Base. These are the errored transactions that you can view through the 
Transaction Error Summary and Details window in the application. The program can be
scheduled to run at a regular interval. To schedule the program:

Steps
1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Install Base Error Correction and Synchronization 
Program.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.
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9. Click Submit.

Final Synchronize On-Hand Balance with Oracle Inventory
To maintain life-cycle tracking for all items that are to be tracked in Oracle Installed 
Base, it maintains a mirror image of what is in Inventory. For new implementations of 
Oracle Installed Base, all on-hand quantities of the Oracle Installed Base trackable items 
were issued out of Oracle Inventory in the first step of the implementation checklist. 
Now you must receive them back into Oracle Inventory. You must ensure that the 
Service Fulfillment Manager queue is up and running before attempting this step. 
Oracle suggests that you use the miscellaneous receipt transaction in Inventory to do 
this step.

Refer to the steps in Oracle Service Fulfillment Manager User Guide to start and make sure 
that the Oracle Service Fulfillment Manager queue is up and running. 
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3
Implementation and Setup for Upgrade 

Users

This chapter covers the following topics:

• Introduction

• Product Dependencies and Requirements

• Setup Checklist for Upgrade Users

Introduction
This chapter provides implementation and setup information for users who have an 
earlier version of Oracle Installed Base and are upgrading to this version. Because you 
are an upgrade user, the application automatically updates much of your current setup. 
Therefore you are required to consider only a subset of the setup steps required for a 
new user.

Product Dependencies and Requirements
The following modules must be installed and set up for Install Base to work. Refer to 
the appropriate guides to install and set up these modules:

• Oracle Inventory

• Oracle Asset Tracking

• Oracle Service Fulfillment Manager

• Oracle Order Management

• Oracle Purchasing (Optional)

• Oracle Accounts Receivable
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• Oracle Work in Process (Optional)

• Oracle Bills of Material

Setup Checklist for Upgrade Users
The following table provides a checklist of setup steps for upgrade users of Oracle 
Installed Base. The entries for section reference in the table direct you to Chapter 2, page
2-1 for detailed step descriptions.

Step 
Numb
er

Title Requir
ed or 
Option
al

Seeded
?

Extensible
?

Section 
Reference

1. Set Up Inventory Serial Control at 
the Master Level, page 2-7

Require
d

NA NA Section 2.3.
2, page 2-7

2. Set Up Oracle Installed Base Items in
the Item Master, page 2-7

Require
d

NA NA Section 2.3.
3, page 2-7

3. Set Up Vendors, page 2-7 Optiona
l

N N Section 2.3.
5, page 2-7

4. Set Up Employees, page 2-8 Optiona
l

N N Section 2.3.
6, page 2-8

5. Verify the Setup of the Oracle 
Service Fulfillment Manager Event 
Queue, page 2-8

Require
d

N N Section 2.3.
9, page 2-8

6. Set Up the Action Menu in Oracle 
Order Management, page 2-9

Require
d

N N Section 2.3.
10, page 2-

9

7. Set Up the Order Management 
Workflow for Non-Shippable Items, 
page 2-10

Require
d

N N Section 2.3.
11, page 2-

10

8. Run the License Manager Program, 
page 2-13

Require
d

N N Section 2.4.
1, page 2-

13
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Step 
Numb
er

Title Requir
ed or 
Option
al

Seeded
?

Extensible
?

Section 
Reference

9. Verify the Setup of Four Profile 
Options for Oracle Asset Tracking, 
page 2-13

Require
d

N N Section 2.4.
2, page 2-

13

10. Verify Location IDs in 
HZ_LOCATIONS, page 2-13

Require
d

Y N Section 2.4.
3, page 2-

13

11. Verify Codes for Asset Update 
Statuses, page 2-14

Optiona
l

Y N Section 2.4.
4, page 2-

14

12. Set Up Codes for Party-Account and
Party-Contact Relationship Types, 
page 2-18

Require
d

Y Y Section 2.5.
2, page 2-

18

13. Verify Codes for Instance 
Relationship Types, page 2-19

Require
d

Y N Section 2.5.
3, page 2-

19

14. Verify Extended Attribute-Level 
Codes, page 2-20

Require
d

Y N Section 2.5.
4, page 2-

20

15. Set Up Extended Attribute Pools, 
page 2-20

Optiona
l

N Y Section 2.5.
5, page 2-

20

16. Set Up Extended Attribute 
Classifications, page 2-21

Optiona
l

N Y Section 2.5.
6, page 2-

21

17. Set Up Extended Attributes, page 2-
21

Optiona
l

N Y Section 2.5.
7, page 2-

21

18. Verify Accounting Classification 
Codes, page 2-21

Require
d

Y N Section 2.5.
8, page 2-

21



3-4    Oracle Installed Base Implementation Guide

Step 
Numb
er

Title Requir
ed or 
Option
al

Seeded
?

Extensible
?

Section 
Reference

19. Verify Codes for Instance Location 
Sources, page 2-22

Require
d

Y N Section 2.5.
10, page 2-

22

20. Verify Party Sources, page 2-23 Require
d

Y N Section 2.5.
11, page 2-

23

21. Set Up Codes for Instance-Operating
Unit Relationship Types, page 2-24

Require
d

Y Y Section 2.5.
12, page 2-

24

22. Set Up the Transaction Subtypes 
LOV from Non-Service Processes, 
page 2-38

Require
d

Y N Section 2.5.
25, page 2-

38

23. Verify Transaction Error Source 
Types, page 2-39

Require
d

Y N Section 2.5.
27, page 2-

39

24. Verify Oracle Configurator Enabled 
Values, page 2-26

Require
d

Y N Section 2.5.
16, page 2-

26

25. Verify Instance Class Values, page 2-
26

Require
d

Y N Section 2.5.
17, page 2-

26

26. Verify Values for the Resubmit 
Interface Process, page 2-27

Require
d

Y N Section 2.5.
18, page 2-

27

27 Verify Values for CSI: Propagate 
Systems Changes, page 2-27

Require
d

Y N Section 2.5.
19, page 2-

27

28. Set Up Regions for the Advanced 
Search Page, page 2-28

Optiona
l

Y N Section 2.5.
20, page 2-

28
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Step 
Numb
er

Title Requir
ed or 
Option
al

Seeded
?

Extensible
?

Section 
Reference

29. Set Up the Results of the Search Item
Instances Page, page 2-29

Optiona
l

Y N Section 2.5.
21, page 2-

29

30. Create Business Users, page 2-40 Require
d

N N Section 2.5.
28, page 2-

40

31. Create Agent Users, page 2-40 Require
d

N N Section 2.5.
29, page 2-

40

32. Schedule the Expire End Dated 
Instances Program, page 2-41

Require
d

N N Section 2.5.
30, page 2-

41

33. Schedule the Install Base Open 
Interface Program, page 2-41

Require
d

N N Section 2.5.
31, page 2-

41

34. Run the Initiate Mass Update 
Program, page 2-42

Require
d

N N Section 2.5.
32, page 2-

42

35. Schedule the Process Old Order 
Lines-Fulfillable Only Program, 
page 2-43

Require
d

N N Section 2.5.
33, page 2-

43

36. Schedule the Resubmit Interface 
Process, page 2-44

Require
d

N N Section 2.5.
34, page 2-

44

37. Schedule the Resubmit Waiting 
Transactions Program, page 2-44

Require
d

N N Section 2.5.
35, page 2-

44

38. Schedule the Install Base and 
Inventory Data Discrepancies 
Program, page 2-45

Require
d

N N Section 2.5.
36, page 2-

45
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Step 
Numb
er

Title Requir
ed or 
Option
al

Seeded
?

Extensible
?

Section 
Reference

39 Schedule the Install Base Error 
Correction and Synchronization 
Program, page 2-46

Require
d

N N Section 2.5.
37, page 2-

46

After upgrading, you must run the concurrent program: Program to initiate 
operational status update. The program requires no parameters. Run this program after
logging in with the Oracle Installed Base Admin responsibility.



Oracle Installed Base System Profile Options and Debug Information    A-1

A
Oracle Installed Base System Profile 

Options and Debug Information

Oracle Installed Base System Profile Options
The following table describes the profile options for Oracle Installed Base. These profile 
options are to be set at the site level.

Profile Options for Oracle Installed Base

Profile Option Name Category Comments

CSI: Allow Install Parameter 
Update 

Debug Use this profile option with great
caution. The default = N. Do 
not alter this setting unless 
instructed to do so as part of 
patching or by Oracle 
Customer Support or 
Development. Changing the 
default can cause 
irrecoverable data corruption.
(This profile option is set to Y 
after migration to allow a 
one-time update to install 
parameters. Then it is set to 
N.) 

For more information, refer to
the discussion of the Override
Ownership check box in 
Section 2.5.1, "Set Up 
Installation Parameters", page
2-15.
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Profile Option Name Category Comments

CSI: Archive Block Size Deployment Defines the number of rows 
that are read and written as a 
unit during the internal 
processes of purging 
transaction history.

CSI: Auto-Generate System 
Name 

Deployment Auto-generate System 
Number at time of system 
creation (Y or N).

CSI: Auto-split Instances 
During Instantiation 

Functional Auto split instances with 
multiple quantity to 1 per 
instance at time of instance 
creation (Y or N).

CSI: BOM Explosion Level Functional Number of BOM levels to 
explode for creation of 
component-of configuration 
from BOM setup (1, 2, 3.). 
Note that BOM explosion 
stops at any level where child 
is at quantity > 1. 

CSI: Cascade System 
Termination 

Functional Cascade system termination 
to instances (Y or N).

CSI: Configurator Enabled Deployment Default = Network Models 
Only. Used for integration 
with the TSO solution and the
Oracle Configurator product.

CSI: Contracts Enabled Deployment Enable Oracle Installed Base 
integration with Oracle 
Service Contracts (Y or N). If 
enabled, an instance will be 
included in the service 
contracts.

CSI: Counters Enabled Debug Enable Oracle Installed Base 
integration with Counters (Y 
or N).

CSI: Debug Level Debug For Debug, set at 9 or 10 for 
Debug to start.
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Profile Option Name Category Comments

CSI: Default Install Date with 
Ship or Fulfillment Date

Functional Optionally populates 
installation date from the 
actual shipment/fulfillment 
date. Previously, the 
installation date for an item 
instance was based on the 
installation date specified in 
the Transaction Details 
window for a sales order line. 
If the date was not entered, 
then the installation date was 
left blank.

CSI: Default Instance Status Functional Default Instance Status at 
time of instance creation. Pick 
one status from the LOV.

CSI: Default Party 
Relationship Type for 
Party/Account Merge

Deployment Provides a default value for 
party relationship type for 
party and account merge 
routines.

CSI: Default Version Label Functional Default version label at time 
of instance creation. Pick one 
from the LOV.

CSI: Display HTML UI Ul Option to use Oracle Installed
Base HTML for display 
(Internal). Used by other 
CRM applications to use the 
Oracle Installed Base HTML 
UI (Y or N).

CSI: Display Impacted 
Contracts

Functional Controls the automatic 
display of a warning page 
indicating the impacted 
contracts, when changes to an
item instance imapct existing 
contracts. Does not affect the 
behavior of the View 
Impacted Contracts button.
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Profile Option Name Category Comments

CSI: Enable Contracts For 
Open Interface

Functional Default = N. A setting of Y 
means that the Oracle Service 
Contracts application creates 
Service Warranties where 
applicable during an Open 
Interface run. Setting the 
profile option to N imports 
data faster than when it is set 
to Y.

CSI: Enable SQL Trace Debug For Debug (Y or N). Set to Y 
to start Debug.

CSI: Explode BOM Functional Enable BOM explosion for top
assembly with Oracle 
Installed Base trackable 
components at time of 
shipment/fulfillment (Y or N).

CSI: Filter Display of all 
Contracts

UI Default = N. If set to Y, the 
application displays only 
active contracts.

CSI: Forms to SSWA Default 
Responsibility

UI Default user for applications 
to launch HTML from forms. 
Default Installed Base User or 
from the LOV.

CSI: IB Tab - Query Only Root
Instances

UI Controls Installed Base tab 
search behavior in the Contact
Center: defaults the value to 
the associated check box in 
the Find window

CSI: IB Tab - Query Threshold UI Controls Installed Base tab 
auto-query behavior in the 
Contact Center: shows the 
result set only if the query 
count is less than or equal to 
the profile option value. For 
other cases, you must use the 
Find window.
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Profile Option Name Category Comments

CSI: Instance Termination 
Status 

Functional Default Termination Status. 
Pick one from the LOV.

CSI: Log file Name Debug The name of the log file for 
Debug.

CSI: Log File Path Debug For Debug ('utl-file-dir' 
parameter in init.ora).

CSI: OA Default Selection of 
the View Dropdown

UI Select a value to default the 
selection of view in the 
dropdown list of the item 
instance search summary 
page. Selecting this option 
will improve the usability by 
defaulting the more 
frequently used view.

CSI: OE Line Processing 
Delay 

Deployment Delay between OE line 
processing. Time between 
order line processing to allow 
for Oracle Installed Base 
update completion to avoid 
record locking. 
Recommended delay: 60 
seconds.

CSI: Open Interface Commit 
Record Limit

Deployment Used to commit Open 
Interface transactions to the 
data base. Default = 1000.

CSI: Process Old Fulfill Lines Deployment Enable the processing of old 
fulfill lines into Oracle 
Installed Base. If enabled, 
Oracle Installed Base will 
attempt to process Oracle 
Order Management 
fulfillment line and create and
or update item instance.
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Profile Option Name Category Comments

CSI: Restrict LOV's on Site 
Usage.

UI Default = N. Set at Site Level. 
For value = Y, the application 
restricts the Installed 
Locations LOV in the Systems
page to customer addresses 
with locations identified as 
Install At.

CSI: Show Expired Instances UI Default = N. Enables users to 
default the value of the Show 
Expired Products checkbox in
the Advanced Search page. If 
the profile option value = Y, 
then the application shows all
instances including expired 
products in the Oracle 
Installed Base UI.

CSI: Stop At Debug Errors Deployment Set to Y to start debug (Y or 
N).

CSI: System Name Update 
Allowed 

Functional System name update allowed 
after system name creation (Y 
or N).

CSI: UI Default Selection of 
View Details Dropdown

UI Defines the default link 
populated in the 'speed menu'
for summary results 
displayed in the Search 
Products page.

CSI: Use Parallel Mode Functional Determines which approach 
(SFM or Concurrent) to use in
order to process order lines in
Oracle Installed Base. If you 
set the profile option value to 
Yes, the IB Transaction Lines 
Import concurrent program 
will process the transaction 
lines.
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Profile Option Name Category Comments

SERVICE Master Inventory 
Validation Organization 

-- Replaces the ASO: Product 
Organization profile option 
obsoleted in a prior release.

During the upgrade process, 
the inventory organization 
specified in this profile is 
used to upgrade customer 
products manually created in 
Oracle Service.

After upgrade, it is used to 
default the Organization field 
value in Oracle Installed Base 
pages.

Setting the Debug Option
Oracle Installed Base provides an option to write debug information in a log file. By 
default, the debug feature is turned off. To turn the debug option off, change the profile 
option CSI_DEBUG_LEVEL value to 0.

To turn the debug option on, perform the following steps:

Steps
1. Change the value of profile option CSI_DEBUG_LEVEL to either 9 or 10.

2. Specify the value of the profile option CSI_LOGFILE_PATH to be the path of the 
directory on the server side where the log file should be written. 

You must choose the log file path from the list of paths defined for the parameter 
utl_file_dir in the init.ora file. Alternatively, you can run the SQL statement:

• SELECT value FROM v$parameter WHERE name = 'utl_file_dir'.

3. Specify the value of profile option CSI_LOGFILE_NAME to be the name you want 
to give to the log file. 

The specified log file will be written in the CSI_LOGFILE_PATH directory on the 
server side, and all debug messages will be written to this file. Each message in the 
log file will have the session ID and username attached to it.

4. Use these settings as required:

• CSI Stop At Debug Errors: Set to Y to start Debug. 
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• CSI Enable SQL Trace: Set to Y to start Trace.
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B
Seeded Data

Introduction
This appendix lists the data that ships with Oracle Installed Base as seeded data, or data
that is shipped "out-of-the-box."

Roles and Permissions
Oracle Installed Base ships with four pre-defined roles, as shown in the following table.

Roles Supported by Oracle Installed Base

Role Code Common Name of Role Description

CSI_CUSTOMER_USER Customer user Has restricted permissions 
that are set up primarily for 
Oracle iSupport users. For 
example, this role does not 
allow such activities as 
instance status updates, 
party/account updates, 
ownership transfers, and 
counter adjustments, but does
allow updates to contacts and 
counter values.

CSI_END_USER End customer user Has update permissions to 
change Oracle Installed Base 
data.
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Role Code Common Name of Role Description

CSI_NORMAL_USER Normal user For internal agent users. Has 
update permissions to change
Oracle Installed Base data.

CSI_READ_ONLY_USER Read-only user Applies to users who only 
need read-only access to 
Oracle Installed Base data.

A role is a combination of permissions. The following table shows the permissions 
supported by Oracle Installed Base.

Permissions Supported by Oracle Installed Base

Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_ACCT_A
CCESS_ONL
Y

Restricts the 
users access 
to Oracle 
Installed Base
instances 
based on an 
Account 

Y N Y Y

CSI_ADDI_A
TTR_UPDAT
E

Update 
permission 
for 
Additional 
Attributes 
page.

N Y Y N

CSI_ADDI_A
TTR_VIEW

View 
permission 
for 
Additional 
Attributes 
page

Y Y Y Y
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_ALL_AC
CT_ACCESS

Allows access
to Oracle 
Installed Base
instances 
across 
accounts and 
parties

N Y N N

CSI_ASSET_
UPDATE

Update 
permission 
for Asset 
page

N Y N N

CSI_ASSET_
VIEW

View 
permission 
for Asset 
page

Y Y N N

CSI_CONTA
CT_DETAIL_
UPDATE

Update 
permission 
for Contact 
Detail page 
(future use)

N Y Y Y

CSI_CONTA
CT_DETAIL_
VIEW

View 
permission 
for Contact 
Detail page

Y Y Y Y

CSI_CONTR
ACT_UPDAT
E

Update 
permission 
for Contract 
page (future 
use)

N Y Y N

CSI_CONTR
ACT_VIEW

View 
permission 
for Contract 
page

Y Y Y Y
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_COUNT
ER_ADJUST
MENT

Access 
permission to
adjust 
Counter 
readings

N Y Y N

CSI_COUNT
ER_HISTORY
_UPDATE

Update 
permission 
for validation
flag in 
Counter 
History page

N Y Y N

CSI_COUNT
ER_HISTORY
_VIEW

View 
permission 
for Counter 
history

Y Y Y Y

CSI_COUNT
ER_PROPER
TIES_ACCES

Access 
permission to
Counter 
properties

N Y Y N

CSI_COUNT
ER_RESET

Access 
permission to
perform 
Counter 
resets

N Y Y N

CSI_COUNT
ER_UPDATE

Update 
permission 
for Counter 
page

N Y Y Y

CSI_COUNT
ER_VIEW

View 
permission 
for Counter 
page

Y Y Y Y

CSI_CREATE
_INST_UPD
ATE

Permission 
for creating 
instance

N Y Y N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_CREATE
_INST_VIEW

View 
permission 
for Create 
Instance page
(future use)

N Y Y N

CSI_CREATE
_SYS_UPDA
TE

Permission 
for creating 
system

N Y N N

CSI_CREATE
_SYS_VIEW

View 
permission 
for csi Create 
System page 
(future use)

N Y N N

CSI_CUSTO
MER_VIEW

This 
permission 
should be 
assigned to 
any user that 
is a customer 
(obsoleted)

Y N Y Y

CSI_DOWNL
OAD

Access 
permission 
for the 
Download 
button 
instance 
search results

Y Y Y Y



B-6    Oracle Installed Base Implementation Guide

Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_EXPIRE_
INSTANCE

Users with 
this 
permission 
can change 
the instance's 
status to any 
terminable 
status, 
provided 
they also 
have the 
CSI_INST_ST
ATUS_UPDA
TE 
permission.

N Y Y N

CSI_GENER
AL_ATTRIB_
CUST_ONLY

Makes certain
Customer 
instance 
attributes 
read only 
(future use)

N N Y Y

CSI_INST_C
ONFIG_UPD
ATE

Update 
permission 
for Instance 
Config page

N Y Y N

CSI_INST_C
ONFIG_VIE
W

View 
permission 
for Instance 
Config page

Y Y Y Y

CSI_INST_G
ENERAL_UP
DATE

Update 
permission 
for Instance 
General page

N Y Y Y

CSI_INST_G
ENERAL_VI
EW

View 
permission 
for Instance 
General page

Y Y Y Y
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_INST_N
OTES_UPDA
TE

Permission to
update the 
instance 
notes

N Y Y N

CSI_INST_N
OTES_VIEW

Permission to
view the 
instance 
notes

Y Y Y Y

CSI_INST_Q
UANTITY_U
PDATE

Permission to
update 
instance 
quantity

N Y Y N

CSI_INST_ST
ATUS_UPDA
TE

Permission to
update 
instance 
status

N Y Y N

CSI_LATEST
_TRANSACT
ION_UPDAT
E

Update 
permission 
for 
Transaction 
History page 
(future use)

N Y Y N

CSI_LATEST
_TRANSACT
ION_VIEW

View 
permission 
for 
Transaction 
History page

Y Y Y Y
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_OP_UNI
T_RESTRICTI
ON

Security 
enhancement 
provided for 
HTML user 
interfaces: 
Restricts a 
user's access 
to records 
based on the 
user's 
operating 
unit. An 
item's Sold 
From 
organization 
is matched 
against the 
user's 
operating 
unit, and 
matching 
instances are 
displayed. If 
the Sold 
From 
organization 
is not set, 
then the item 
instance is 
not included 
in search 
results.

N N N N

CSI_OPERAT
INGUNIT_U
PDATE

Update 
permission 
for Operating
Unit page

N Y N N

CSI_OPERAT
INGUNIT_VI
EW

View 
permission 
for Operating
Unit page

Y Y N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_ORGAN
IZATION_VI
EW

Permission to
view 
organization 
name

Y Y N N

CSI_PARTY_
ACCOUNT_
UPDATE

Update 
permission 
for Party 
Account page

Y Y N N

CSI_PARTY_
ACCOUNT_
VIEW

View 
permission 
for Party 
Account page

N Y N N

CSI_PARTY_
CONTACT_
UPDATE

Update 
permission 
for Party 
Contact page

N Y Y N

CSI_PARTY_
CONTACT_
VIEW

View 
permission 
for Party 
Contact page

Y Y Y Y

CSI_PARTY_
SUMMARY_
UPDATE

Update 
permission 
for Party 
Summary 
page (future 
use)

N Y N N

CSI_PARTY_
SUMMARY_
VIEW

View 
permission 
for Party 
Summary 
page

Y Y N N

CSI_PARTY_
UPDATE

Update 
permission 
for Party 
page

N Y N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_PARTY_
VIEW

View 
permission 
for Party 
page

Y Y N N

CSI_PERZ_E
DIT_UPDAT
E

Ability to 
update saved 
searches in 
Advanced 
Search page

Y Y Y Y

CSI_PERZ_E
DIT_VIEW

Ability to 
view saved 
searches in 
Advanced 
Search page

Y Y Y Y

CSI_PRICIN
G_UPDATE

Update 
permission 
for Pricing 
Attributes 
page

N Y Y N

CSI_PRICIN
G_VIEW

View 
permission 
for Pricing 
Attributes 
page

Y Y Y N

CSI_PROPER
TY_READ

Read the 
Instance 
Properties 
(future use)

Y Y Y N

CSI_PROPER
TY_UPDATE

Update the 
Instance 
Properties 
(future use)

N N N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_REPAIR
_ORDER_UP
DATE

Update 
permission 
for Repair 
Order page 
(future use)

N Y Y N

CSI_REPAIR
_ORDER_VIE
W

View 
permission 
for Repair 
Order page

Y Y Y Y

CSI_SEARCH
_ASSET_RES
_UPDATE

Update 
permission 
for Search 
Asset Result 
page (future 
use)

N Y N N

CSI_SEARCH
_ASSET_RES
_VIEW

View 
permission 
for Search 
Asset Result 
page

Y Y N N

CSI_SEARCH
_ASSET_UPD
ATE

Update 
permission 
for Search 
Asset page 
(future use)

N Y N N

CSI_SEARCH
_ASSET_VIE
W

View 
permission 
for Search 
Asset page

Y Y N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_SEARCH
_PRODUCT_
UPDATE

Update 
permission 
for Instance 
Search 
Results page, 
for example, 
ability to use 
Create, 
Expire, etc 
buttons

N Y Y Y

CSI_SEARCH
_PRODUCT_
VIEW

View 
permission 
for Instance 
Search 
Results page

Y Y Y Y

CSI_SEARCH
_SYS_UPDA
TE

Update 
permission 
for System 
Search 
Results page, 
for example, 
ability to use 
Create, 
Update 
buttons

N Y N N

CSI_SEARCH
_SYS_VIEW

View 
permission 
for System 
Search 
Results page

Y Y N N

CSI_SEARCH
_TRANSACT
ION_UPDAT
E

Update 
permission 
for Search 
Transaction 
page (future 
use)

N Y N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_SEARCH
_TRANSACT
ION_VIEW

View 
permission 
for Search 
Transaction 
page

Y Y N N

CSI_SERVIC
E_REQUEST_
UPDATE

Update 
permission 
for Service 
Request page

N Y Y Y

CSI_SERVIC
E_REQUEST_
VIEW

View 
permission 
for Service 
Request page

Y Y Y Y

CSI_SHOW_
ALL_CONTA
CTS

Allows 
Oracle 
Installed Base
User to view 
all types of 
contacts

Y Y N N

CSI_SHOW_
ALL_LOCAT
IONS

Allows the 
Oracle 
Installed Base
user to view 
all types of 
locations, it 
overrides any
restriction on 
location such 
as 
CSI_SHOW_
EXT_LOCAT
IONS, 
CSI_SHOW_
EXT_LOCN_
PROD

Y Y N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_SHOW_
ALL_PARTIE
S

Allows the 
user to View 
all types of 
parties 
including 
Employees 
etc CSI

Y Y N N

CSI_SHOW_
EXT_CONTA
CTS

Restricts 
Oracle 
Installed Base
User to view 
only the 
external 
contacts

Y N Y Y

CSI_SHOW_
EXT_LOCAT
IONS

Restricts the 
Oracle 
Installed Base
user to view 
only external 
locations

Y N Y Y

CSI_SHOW_
EXT_LOCN_
PRD_ONLY

Security 
enhancement 
provided for 
HTML user 
interfaces: 
Restricts a 
user to be 
able to 
retrieve only 
those records 
that are 
customer-ite
ms located at 
external sites.

N N N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_SHOW_
EXT_PARTIE
S

Restricts the 
user to View 
only the 
External 
parties 
(future use)

Y N Y Y

CSI_SHOW_I
NST_CUSTO
MER_MENU

Permission to
display the 
Installed Base
Customer 
facing 
instance 
details Menu

Y N Y Y

CSI_SHOW_I
NST_MENU

Permission to
display the 
Installed Base
Agent facing 
instance 
details Menu

N Y N N

CSI_SPLIT_Q
UANTITY_U
PDATE

Update 
permission 
for Split 
Quantity 
page

N Y Y N

CSI_SPLIT_Q
UANTITY_VI
EW

View 
permission 
for Split 
Quantity 
page

N Y Y N

CSI_SYS_CF
G_VIEW

View 
permission 
for System 
configuration
s

Y Y Y Y
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_SYS_DT
L_UPDATE

Update 
permission 
for System 
Detail page

N Y Y Y

CSI_SYS_DT
L_VIEW

View 
permission 
for System 
Detail page

Y Y Y Y

CSI_TRANS
ACTION_DE
TAIL_UPDA
TE

Update 
permission 
for 
Transaction 
Detail page 
(future use)

N Y Y N

CSI_TRANS
ACTION_DE
TAIL_VIEW

View 
permission 
for 
Transaction 
Detail page

Y Y Y N

CSI_TRANS
ACTION_IN
STANCE_UP
DATE

Update 
permission 
for Instances 
For A 
Transaction 
page (future 
use)

N Y Y N

CSI_TRANS
ACTION_IN
STANCE_VI
EW

View 
permission 
for Instances 
For A 
Transaction 
page

Y Y Y Y

CSI_TRANSF
ER_OWNER_
UPDATE

Update 
permission 
for Instance 
Owner page

N Y N N
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Name Description Read Only 
User

Normal User End 
Customer 
User

Customer 
User

CSI_TRANSF
ER_OWNER_
VIEW

View 
permission 
for Instance 
Owner page

Y Y N N
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C
Processing Errors

Overview
Many Oracle applications have transactions that update Oracle Installed Base as part of 
their normal processing. This chapter describes how to perform corrective procedures 
to reprocess transactions that failed to update Oracle Installed Base successfully.

This chapter contains the following topics:

• Using the Transaction Error Summary and Details Window, page C-1

• Using the Installed Base and Inventory Data Discrepancy Program, page C-6

• Using the Installed Base Error Correction and Synchronization Program, page C-6

Using the Transaction Error Summary and Details Window

Overview
In the Transaction Error Summary and Details window you can reprocess transactions 
that failed to update Oracle Installed Base from certain Oracle applications.

Oracle Installed Base has the following integration points with Oracle applications 
through the Oracle Service Fulfillment Manager (SFM) Advanced Queue and Oracle 
Installed Base processing:

• Inventory receiving and purchase order receiving

• Inventory transactions

• Order management

• RMA receiving
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• Sales order shipping

• Sales order fulfillment

• Fixed assets

• Projects

• Work in process

• Telco Service Ordering

• Intercompany drop shipments and PO adjustments

If a source transaction is successful and the Oracle Installed Base update errors-out, 
then the transaction appears with error text in the Transaction Error Summary and 
Details window. You can correct the error, typically using the Transaction Details 
window. Then you can select the transaction and reprocess it to update Oracle Installed 
Base. If the transaction is successful, then the error record is removed from error tables. 
Otherwise, the error record continues to be available in this window.

Use this procedure to reprocess a transaction.

Steps
1. From the Responsibilities menu of the Oracle Forms mode, select the Oracle 

Installed Base Admin responsibility, and click OK.

2. Navigate to Transaction Errors Processing. 

The Find Transaction Errors window appears and provides a wide range of search 
criteria.

3. Specify your search criteria, and click Find. 

The Transaction Error Summary and Details window appears.
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4. Browse detailed information under the main Transaction Error Summary region, in 
the Transaction Error tab, the Lot/Serial/Instance tab, and Inventory Transaction 
tab, and through the Transaction Detail and Instance Detail buttons.

The Transaction Detail button is available only for specific transaction errors: OM 
shipments, RMA receipts, and RMA fulfillment (cancellation) where transaction 
details have previously been entered in source transactions.

The Instance Detail button is available only where item instances already exist for 
the error transaction.

5. Correct the transaction.

For example, if you receive an error for an RMA fulfillment transaction: 
"Transaction details are mandatory for cancellation / RMA fulfillment," then click 
Transaction Detail and enter instance number information in the Transaction 
Details window.

6. Select the corrected transaction to be reprocessed by selecting its Process Flag check 
box.

7. Save the data to commit the changes.
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8. From the main Functions menu, select Others > Requests.

9. Choose the Resubmit Interface Process concurrent program from the LOV. 

10. Choose the Selected parameter to process selected transactions.

11. Submit the request.

12. Optionally, schedule this job to run at regular intervals.

The following table describes the fields in the Transaction Error Summary and Details 
window.

Location in the Window Field Description

Top Process Flag Select this check box to 
reprocess the related 
transaction. After you select 
this box and save the record, 
the concurrent program will 
pick it for reprocessing.

Top Transaction Type The type of the failed 
transaction. A transaction 
type is predefined in the 
Oracle Installed Base source 
transaction types. For 
example, if the error occurred 
while performing an 
inter-organizational 
transaction, then the 
transaction type is 
INTERORG_TRANSFER.

Top Material Transaction Id The inventory material 
transaction ID corresponding 
to the Oracle Installed Base 
transaction.

Top Error Messages The exact reason of the error. 
You must correct this cause to
reprocess the transaction.
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Location in the Window Field Description

Top Source Type The source of the transaction 
type. It provides more details 
for the transaction type. For 
example, if the transaction 
type is 
INTERORG_TRANSFER, 
then the source information 
type is 
MTL_MATERIAL_TRANSAC
TIONS. Some of the possible 
Source Info types are 
ASSET_CREATION, 
ASSET_MOVE, CSISOSHP, 
MTL_MATERIAL_TRANSAC
TIONS, 
NORMAL_ITEM_ASSET, 
NORMAL_ITEM_EXP_ITEM,
and WFM_TRANSACTIONS.

Top Source Id The transaction ID 
corresponding to the Oracle 
Installed Base transaction if 
the source is not Inventory. 

Transaction Error Tab Header Reference Represents the source 
transaction reference number.
For example, if the source 
transaction originated from 
an Order Management sales 
order, then this field would 
provide the sales order 
number. 

Transaction Error Tab Header Reference Id The document header ID, 
such as an order header ID.

Transaction Error Tab Line Reference The document line number, 
such as an order line number.

Transaction Error Tab Line Reference Id The document line ID, such as
an order line ID.
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Using the Installed Base and Inventory Data Discrepancy Program
Oracle Inventory and Oracle Installed Base can be out of synchronization for several 
reasons, of which the following two are the most important:

• The Installed Base Tracking box may have been selected and cleared several times 
for the same item, thus leading to a discrepancy between information that the two 
applications show.

• The SFM Event Manager was not set properly and hence some Oracle Inventory 
transactions were not tracked.

The Installed Base and Inventory Data Discrepancies program picks up the discrepancy 
data from the tables of Oracle Installed Base and Oracle Inventory and displays it on a 
report. A separate concurrent program, Installed Base Error Correction and 
Synchronization Program, is available to correct the discrepancies.

Also, Oracle Installed Base provides a notification to an end user if any discrepancy 
between Oracle Installed Base and Oracle Inventory occurs. This is accomplished by 
using an Oracle Alert. The notification generally is in the form of a text message, which 
is sent to the user either by e-mail or paging.

Use this procedure to run the program.

Steps
1. Using the Oracle Installed Base Admin responsibility, navigate to Others > 

Requests. 

The Submit a New Request window appears.

2. Select Single Request, and click OK. 

The Installed Base Requests window appears.

3. From the Name LOV, select Installed Base and Inventory Data Discrepancies, and 
click OK. 

4. As required, click Help for online help in completing the submission of your 
request.

Using the Installed Base Error Correction and Synchronization Program
Installed Base Error Correction and Synchronization Program is a concurrent program 
to correct and reprocess the transactions that failed to update item instances in Oracle 
Installed Base. These are the errored transactions that you can view through the 
Transaction Error Summary and Details window in the application. The transactions 
could have errored for many reasons including, but not limited to, using unsupported 
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transactions. 

Use this procedure to run the Installed Base Error Correction and Synchronization 
Program.

Steps
1. Using the Oracle Installed Base Admin responsibility, navigate to Others > 

Requests. 

The Submit a New Request window appears.

2. Select Single Request, and click OK. 

The Installed Base Requests window appears.

3. From the Name LOV, select Installed Base Error Correction and Synchronization 
Program, and click OK. The Parameters window appears.

4. Select the desired value for the Mode of Execution parameter. 

Valid values for Mode of Execution are defined as follows:

1. R: Report bad setup and data issues that need manual correction.

2. C: Correct and reprocess only the errored transactions.

3. S: Correct and reprocess the errored transactions and resynchronize item 
instances in Oracle Installed Base with the inventory-on-hand balance to 
prevent possible future errors.

Oracle recommends that you run this program in the following sequence:

4. Run the program in mode R to generate the reports, and then manually correct 
the setup and data until the reports show no more discrepancies.

5. Next run the program in mode C for at least few iterations, such as three to 
four, or until no more errored transactions remain to process.

6. Finally run the program in mode S to synchronize Oracle Installed Base and 
Oracle Inventory.

5. Select the desired value for Show Instances.

This parameter is used for generating the Non Serialized Items RMA report. This 
report lists all the RMA receipts that errored out in Oracle Installed Base because 
the mandatory item instance references for the non-serialized items were not 
entered in the Oracle Installed Base transaction details. Valid values for Show 
Instances are as follows:

1. N: Only the RMA transaction details are listed.
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2. Y: All the appropriate item instances that can be used to reference in transaction
details are also listed.

Oracle recommends that you run the program with the Y option for at least the 
first iteration.

6. Click OK. You are returned to the main window.

7. As required, click Help for online help in completing the submission of your 
request.

The following applies only when the program is run in the synchronization mode:

1. You must shut down the SFM event manager queue before you run an iteration in 
the synchronization mode. Any Oracle Installed Base related messages that are still 
pending in the SFM queue are then dequeued and processed by the correction 
program.

2. To get a consistent snapshot of the inventory on-hand balance, the program while 
running in the synchronization mode creates a trigger, 
CSI_BLOCK_MAT_TXN_TRG, on the Oracle Inventory mtl_material_transactions 
table to block any transactions that are performed in Oracle Inventory for an Oracle 
Installed Base trackable item. After the program completes, this trigger is dropped, 
and you then need to reprocess any such failed inventory transactions using the 
standard error submission UIs provided by Oracle Inventory.

3. Start the SFM event manager queue back after the program completes.

The following section contains information about the reports that the program 
produces.

Error Correction Reports

Title
IB Trackable Flag Discrepancy Report

Description
This report lists all the Items that have a value for the Track in Installed Base flag set 
differently in child inventory organizations than in the master inventory organization.

When to Correct
Before you can run the program in the Correction mode.

How to Correct
Installed Base Tracking must be set up and controlled at the inventory item master 
organization. If this is not the case, then business users must verify and appropriately 
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decide which items to track or not to track. To achieve this:

1. Apply Oracle Inventory Patch 3038264. This patch honors the value on the 
inventory master organization for the Installed Base Tracking flag and apply it on 
all the child inventory organizations.

2. You may then want to use the Inventory item master window to verify and correct, 
if required, the Installed Base Tracking flag for these items. You may have to 
deplete Inv. on-hand balances to zero to update the flag.

Title
Serial Number Uniqueness Violation Across Inventory Organizations Report

Description
This condition occurs when the serial number uniqueness in Oracle Inventory is defined
as Across Organizations and you manually create the item instance with a specific serial
number in Oracle Installed Base and then transact the same serial number in inventory 
for a different item. This report lists all such item instances and their serial numbers.

When to Correct
Before you can run the program in the Synchronization mode.

How to Correct
Business users must validate the serial numbers in question here and retain the valid 
one. One possible way to achieve this is to prefix or suffix the serialized instance in 
Oracle Installed Base, which in most cases is a manually created customer item, and or 
expire any of them if they were created inappropriately. You can use the public APIs 
provided by Oracle Installed Base can to perform this.

Title
Report on RMAs for Non Serialized Items Which Have No Item Instance References

Description
For non-serial items, providing an item instance reference in transaction details is 
mandatory. This report lists all such RMAs that errored because they do not have an 
item instance referenced in transaction details for that RMA line. It also shows those 
there is no transaction detail entered.

When to Correct
Before you can run the program in the Synchronization mode.

How to Correct
The report has a parameter Show Instances, which is prompted at the time of execution 
of the correction program. A value of Y displays the list of instances that can be 



C-10    Oracle Installed Base Implementation Guide

referenced for the errored RMA Lines.Business users should look at the list of instances 
and then do the following:

1. With the Order Management responsibility, navigate to Sales Order > Lines > 
Actions (Installation Details UI) to create or update the transaction detail and then 
reference the appropriate instances. 

2. With the Oracle Installed Base Admin responsibility, navigate to the Transactions 
error reprocessing UI and mark all the corrected RMA errors for reprocessing.
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